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Introduction
This manual introduces you to DoStudio Authoring, a complete Blu-ray Disc™ authoring application from 
Sony Creative Software.

The information in this manual is designed for beginning to intermediate users, especially users who are 
unfamiliar with a few or all of the concepts of Blu-ray Disc authoring. Don't be fooled by the simple and 
straightforward nature of the application, however. DoStudio Authoring is a powerful, BD-ROM 
specification compliant authoring system with full AACS support, BDCMF formatting, BD-J support, and 
more. The power of DoStudio Authoring lies in its ease of use.

This manual assumes that the you have a fundamental understanding of the graphics formats used for 
Blu-ray Disc menus such as PSDs, PNGs, and the like. It also assumes that you are reasonably skilled in the 
use of Adobe Photoshop, or have access to someone who does. Blu-ray Disc menus are graphics-intensive 
and much of the success of your Blu-ray Disc project will depend on the quality of your graphic design.

Technical support
E-mail your support requests to the Sony Creative Software DoStudio team at 
DoStudioSupport@am.sony.com.

You can also call the DoStudio team from 9 A.M. to 5 P.M. Central Time, Monday through Friday, 
excluding company holidays.

 n North America: (866) 650-7768 (toll free)

 n International: (608) 203-2370

About your rights in DoStudio Authoring software
DoStudio Authoring software is licensed to you under the terms of the End User License Agreement you 
entered into with Sony Creative Software Inc.

About your privacy
Sony Creative Software Inc. respects your privacy and is committed to protecting personal information. 
Your use of the software is governed by the Software Privacy Policy. Please review its contents carefully as 
its terms and conditions affect your rights with respect to the information that is collected by the software. 
For your reference, a copy of the Software Privacy Policy is located at 
http://www.sonycreativesoftware.com/corporate/privacy.

Chapter 1
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Proper use of software
DoStudio Authoring software is not intended and should not be used for illegal or infringing purposes, such 
as the illegal copying or sharing of copyrighted materials. Using DoStudio Authoring software for such 
purposes is, among other things, against United States and international copyright laws and contrary to the 
terms and conditions of the End User License Agreement. Such activity may be punishable by law and may 
also subject you to the breach remedies set forth in the End User License Agreement.

Terminology
This manual uses some terminology that is commonplace in Blu-ray Disc parlance but may seem peculiar 
or confusing if you are new to Blu-ray Disc authoring. This manual also uses some terminology that is 
specific to DoStudio Authoring. We explain a few of them here before you get too far.

DSA

DSA stands for DoStudio Authoring, which is the Blu-ray Disc authoring tool that is about to enable you to 
efficiently create professional Blu-ray Disc menus.

Blu-ray Disc vs. BD

BD is the official acronym for Blu-ray Disc. At times in this manual we spell out Blu-ray Disc, at other times 
we use the acronym.

Author

When we say "DVD author" or "BD author" or just "author" we are referring to the person who is creating, 
programming, and designing the disc. Because you are reading this manual, that author is probably you.

Viewer

When we say the Viewer, we are referring to the person who is watching the Blu-ray Disc that you have 
created. The viewer may be watching your disc on a set-top Blu-ray Disc player, a PlayStation®3, or a 
computer software player such as ArcSoft TotalMedia Theatre.

Pop-up menu

A pop-up menu is a feature found on all professional Blu-ray Disc titles. Unlike DVDs, which require you to 
interrupt the video in order to access the menu, the Blu-ray Disc format allows you to display your menu 
over the video stream while it is still playing. DoStudio Authoring creates pop-up menus with ease.

BD-Live

BD-Live™ is the rather catchy name given to the Internet capabilities of the Blu-ray Disc format. BD-Live 
allows you to play games with others online, download content and use social networking sites to name a 
few oft-cited examples.
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Actions

Actions are unique to DoStudio Authoring. Actions are playback or navigational behaviors that you can 
assign to buttons to create interactivity on your Blu-ray Disc. Actions are assigned via an expandable menu 
in the Control Panel window. Actions take the place of hand-scripting code, so love them!

BD-R/-RE

Throughout this manual we often refer to BD-R/-RE when discussing burning a disc. BD-R is the name for 
the writable Blu-ray Disc format. BD-RE is the name for the rewritable Blu-ray Disc format. All Blu-ray Disc 
burners support both BD-R and BD-RE. There is no functional difference between the two formats. The 
obvious difference is that BD-Rs can be used only once, whereas a BD-RE can be reused multiple times. 
Considering that the cost of rewritable media is still relatively high, we recommend using BD-RE for burning 
and testing your discs.

Multiplexing/muxing

Multiplexing and muxing are different words for the same operation. In this manual they are used 
interchangeably. Multiplexing is the process of converting your project's elementary audio and video 
streams into the file types and structure that are readable by a Blu-ray Disc player.

Product philosophy
We are committed to making professional Blu-ray Disc authoring practical for the mid-sized producer, so 
we set out to create the ideal tool for DVD authors who are making the transition to Blu-ray Disc authoring. 
Rather than simply map a tool to the Blu-ray Disc specification, DoStudio Authoring maps the DVD 
authoring workflow to Blu-ray Disc creation.

In order to do this, we have identified the most pressing needs of the professional authoring community 
and designed DoStudio Authoring to specifically meet those needs efficiently and affordably: pop-up 
menus, picture-in-picture, BD-Live, and a robust plug-in architecture for inclusion of third party BD-J 
applications such as games.

The current release of DoStudio Authoring supports pop-up menu creation, Blu-ray 3D™ support, picture-in-
picture support, support for third-party BD-J (including BD-Live features) and BDCMF (BD25 & BD50) 
formatting with AACS support for replication. In other words, DoStudio Authoring does everything you 
need to make a professional Blu-ray Disc today. Which features are available to you depends upon which 
licenses you have purchased. For more information, see http://www.sonycreativesoftware.com/dostudio.
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DoStudio Authoring basics
DoStudio Authoring replaces the complexity of the Blu-ray Disc™ specification with simple to understand 
concepts that any DVD author can learn quickly. This section briefly explains the concepts and terminology 
that are essential to working with DoStudio Authoring successfully.

Menu elements
Let's begin with the elements that comprise a pop-up menu. When building menus in DoStudio Authoring, 
you will be working with three basic elements: menu blocks, sets, and buttons.

Menu blocks

Menu blocks are rectangular areas of the screen, defined by you, the author, that contain a menu such as 
your main menu, or a submenu such as a menu for chapter selection or special features. DoStudio 
Authoring can accommodate 32-bit graphics for your menus (HDMV-only tools can accept only 8-bit 
graphics). Menu blocks cannot overlap on screen. They typically have a background image that defines the 
block's size on the screen; however, menu blocks can be transparent. You can create as many menu blocks 
as your project requires.

By default, the menu block that is listed at the top of your project's menu tree is the menu block that is 
associated with the pop-up menu button on the Blu-ray Disc player's remote control. In other words, it will 
toggle on and off screen when the viewer presses the pop-up menu button. You can change which menu 
block is associated with the pop-up menu button using actions, so you can program your disc to display a 
different pop-up menu depending on what part of the disc is playing.

Chapter 2
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Menu blocks can animate on and off screen. They can float, or "pop up," over your video while it is playing. 
Menu blocks are the parent element of a menu. This means that any other menu elements live inside them 
and are attached to them. When you delete a menu block, any sets or buttons contained in that menu 
block are also deleted. If you animate a menu block, all of the sets or buttons contained in that menu block 
also animate.

Sets

Sets are visual layers of a menu block. Every menu block must have at least one set. A good way to think of 
sets is as visual layers of your menu block that are stacked on top of each other. Each set contains its own 
set of buttons (hence the name "set"), and each set can contain its own background image or it can be 
transparent. Only one set can be visible at a time. A practical example is best to illustrate this concept:

Imagine you have a movie with 15 chapters and you would like to create a chapter menu that allows the 
viewer to select any of the 15 chapters for viewing. Simple enough, right?  One way to do this is to create a 
menu block and add 15 buttons to it (we'll discuss buttons below).

But what if your graphic designer wants to include nice icons for each chapter and group the icons five at a 
time on the menu block for the sake of visual appeal?  This is where sets come in. You can create three sets 
in your menu block, each with five buttons on it.

Sets can each have their own background image, or they can be transparent. Only one set in each menu 
block can be visible on screen at a time.

Buttons

Buttons are a pretty straightforward concept if you have ever authored a DVD. A button is an area on a 
menu block that is selectable and clickable with a remote control. Buttons are used to play video or to 
display new menu items.

In Blu-ray Disc authoring and in DoStudio Authoring, buttons have three images associated with them. 
Each image corresponds to a state that the button can have: normal, selected, and activated. The normal 
state is what the button looks like when the viewer has not selected it with the remote control. The selected 
state is what the button looks like when the viewer has navigated to that button using the remote control. 
The activated state is what the button looks like when the viewer has clicked enter on the remote control. 
The activated state is usually seen only for the brief amount of time after the viewer has pressed Enter and 
before a video is played or another menu item appears.

A button is required to have an image for its normal state. The selected and activated states are optional. If 
you do not add a graphic for the selected or activated state, the graphic for the normal state is displayed.

Attention DVD authors!

As described above, the method for creating buttons for Blu-ray Disc menus is quite different from 
creating buttons for DVD menus. There is no "overlay" layer such as you are accustomed to using in 
DVD authoring. You (or your menu designer) must create three separate images for a button. Each 
image corresponds to an image state. Your menu designer will be pleased with this new capability, 
because he or she will no longer be limited to a simple 8-bit graphic overlay. With DoStudio Authoring, 
they can create full 32-bit graphics that appear for each image state. DoStudio Authoring can import 
all of these graphics directly from a layered PSD file.
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The image buffer
A new concept for DVD authors is managing the image buffer for the graphics you include in menus. In 
DoStudio Authoring, this includes your pop-up menus and your First Play image.

DoStudio Authoring creates all of the pop-up menus as BD-J (Blu-ray Disc Java) so you can use 32-bit 
graphics. The image buffer size varies depending on the profile of the Blu-ray Disc player. BD-J allows a 
maximum graphics buffer size of 45.5 MB for profile 1.0/1.1 players and 61.5 MB for profile 2.0 players.

These numbers are misleading, however, because you cannot cram 45.5 MB of graphics into the buffer and 
expect your disc to function properly on many Blu-ray Disc players due to the overhead of processing the 
graphics.

We have found though extensive testing that all players can handle 32.5 MB of graphics buffer and 
DoStudio Authoring limits you to 32.5 MB so that your discs will play successfully on all players. When you 
compile your project or run the validation in the Control Panel, DoStudio Authoring calculates the total file 
size for each menu element and warns you if you have exceeded the 32.5 MB limit.

How is the image buffer size calculated?

The size of the image buffer is based the fact that each pixel in an image uses 4 bytes of memory. This is 
because every pixel uses four colors: red, green, blue, and an alpha channel to determine the color and 
transparency of the image. The equation for calculating the image buffer size is as follows:

Width x Height x 4 = number of bytes

For example, an image that is 1920x128 image takes up 124 KB of space:

1920 x 128 x 4 = 124,000 bytes

Tips for managing the image buffer size

 n Do not create images with a lot of extra transparencies around the actual image. Even a 
transparent pixel takes memory.

 n Create a small first play image, such as the text loading.

 n Reuse a background image for all sets by placing the background image on the menu block instead 
of on each set.

 n Remove any images for the selected and activated state that are not being used.

 n Keep in mind a wide image that is applied to a set can be used to remove a lot of extra pixels from 
memory.

 n Keep in mind an image that is 512 pixels by 256 pixels will take up 1 MB of image memory.

 n Design your menu using rectangles and keep track of a rough estimate of how many bytes each 
rectangle will use. Remember buttons have up to three images per rectangle.
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Actions
Actions are another unique feature of DoStudio Authoring. Actions are functions that create the interactive 
functionality of your Blu-ray Disc. Some sample actions are: Play Chapter, Show Menu, Play Sound, and 
many more. Actions are assigned in the Action Editor, which is found in the Control Panel when you have 
selected an element that is able to receive an action. For more information, see "Using actions" on page 
103.

Actions can be assigned to the following elements in your project:

 n Menu Navigation Buttons (Enter, Up, Down, Left, Right)

 n Menu Block Events (On Show, On Hide) and Menu Button Events (On Show)

 n Remote Control Buttons (Play, Pause, Pop Up Menu, Rewind, Fast Forward, Red Button, Green 
Button, Blue Button, Yellow Button)

 n Title Start

 n Title End

 n Chapter Start

Playlist tree elements
The Playlist tree elements determine how the video is laid out on your Blu-ray Disc.

Audio/video segments

Your audio, video, and subtitle assets are added to your project as audio/video segments. Each segment 
can contain one elementary video stream (2D or 3D), up to nine audio tracks, and up to 32 subtitle tracks. 
You can add up to 999 audio/video segments to your project.

2D segments can also contain one secondary video track (used for picture-in-picture effects) and up to nine 
secondary audio tracks. A 3D segment uses two video files, a base view and a dependent view.
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Slideshow segments

A slideshow segment allows you to add up to 100 JPEG images in HD or SD resolution that will display on 
screen for up to 255 seconds. You can add audio tracks to slideshow titles just as you would a video title. 
Viewers can navigate through the slideshow images using their remote control while the audio plays 
uninterrupted.

Playlists

After you have created your audio/video segments, you must add them to playlists. You can add the same 
audio/video segments to multiple playlists without taking up extra capacity on the disc.

A playlist contains playback and navigational information about how your video will play on your Blu-ray 
Disc. You can add a single audio/video segment to a playlist, or you can add multiple audio/video 
segments to a playlist and join them seamlessly. In DoStudio Authoring, this is represented visually in a 
timeline. This is analogous to how video is organized in tracks on a timeline when authoring a standard 
DVD.

When you add an audio/video segment to a playlist it becomes a path item. You can define chapter points 
for each path item. The chapters are defined by the timecode of each path item, not of the entire playlist. If 
you have added the same audio/video segment to multiple playlists, you are allowed to define different 
chapter points for each path item.

Playlists have Start and End events that you can add actions to. This allows you to add authoring features 
such as showing or hiding menu blocks every time a playlist starts or ends. Chapters have a Start event to 
which you can add actions.
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You will notice that when you jump playback from one playlist to the next, there is a delay and often 
the screen will go black. This is normal due to a provision in the Blu-ray Disc specification that requires 
the Blu-ray Disc player to stop any time the disc changes playlists.  The actual delay will vary from 
player to player, but it is normal for the player to pause for roughly two seconds.

Blu-ray Disc titles

By default your project will have one Blu-ray Disc title called the "DoStudio BD-J Menu" title. All of your 
playlists are contained in this title and the BD-J menu is active across all of the playlists. You can see the 
playlists represented visually in the title timeline.

The Blu-ray Disc titles node in the Playlist tree is where you set up your loading screen. This allows you to 
define what graphic is displayed on screen while the player loads the BD-J into memory. The amount of 
time this loading screen is displayed on screen depends upon the speed and quality of the Blu-ray Disc 
player and the amount of graphics you have included in your menus.

You can position playlists before the loading screen if you desire. These playlists will play before the BD-J 
menu loads into the player's memory. This can be useful for displaying warnings, logos, or trailers.

The playlist directly to the right of the Loading Screen in the timeline will play after the menus have loaded. 
After that, the playback order of the playlists is determined by the On End Play events and actions that you 
author into your project.

For more information about setting up your playlist, see "Setting up your playlist" on page 47.
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Authoring workflow

Planning
You're probably tired of hearing people talking about the importance of planning your Blu-ray Disc™ 
production. Chances are, you can knock out a DVD with very little planning at all. But keep in mind that the 
Blu-ray Disc format introduces new interactive capabilities, new graphics requirements, and mandatory 
protection schemes for replication.

A few items to think through before beginning your project:

Flowchart the interactive aspects of the disc

It is important to think through how the user will interact with the menu system and other interactive 
features of the disc.  Create a flowchart.  Think through every button on the remote control.  Will your main 
program start automatically or will you create a video loop that your pop-up menu will appear over at 
program start?

Naming conventions

If you are working with a team of authors and graphics designers, establish a naming convention for your 
graphics particularly as they describe menu elements and button states. Many an authoring job has been 
delayed due to confusion over the minutiae of which graphic is supposed to be the selected button state vs. 
the activated state. These are new concepts if you have come out of a DVD authoring background.

Bit rate budgeting

While the great capacity of Blu-ray Disc leads to fewer headaches over fitting your project onto a disc, it is 
still important to plot out the size and bit rate of your assets.

Chapter 3
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Will your disc be replicated?

If so, AACS is mandatory. DoStudio Authoring prepares your disc for the AACS encapsulation process that 
occurs at the replication plant, but the content owner will need to execute the AACS Provider Agreement in 
advance. If you are not replicating your disc then you do not need to apply AACS. Please read our 
wikipaper on AACS found on the our website for more details: 
http://www.netblender.com/main/resources/wikipapers/aacs-for-independent-producers/ 

Graphics creation
Your menus rely heavily on graphic images, so you must create them before you begin the authoring 
process.  You always have the option of updating your graphics while you are in the middle of the authoring 
process; however, the better prepared your graphics are at the beginning, the smoother your authoring 
process will be.

If you have designed menu graphics for DVD, you will need to shift your designs conceptually from 
thinking of the menu as an entire screen (720 x 480 at 72 dpi for DVD) to thinking of menus as comprised 
of individual elements  that can float over the video anywhere on the screen (1920 x 1080 at 72 dpi for Blu-
ray Disc).  So while the entire canvas for a Blu-ray Disc is quite large, your main menu may only take up 20 
percent of the screen because it pops up over the video.  Of course, the actual sizes of your menu elements 
are up to you and more importantly the specific requirements of the Blu-ray Disc you are authoring.

DoStudio Authoring lets you import 32 bit PNGs (24 bit + 8 bit transparency) for individual menu elements 
such as the background image for your menu blocks.

DoStudio Authoring lets you import an entire menu structure as a layered PSD file.  This is by far the most 
efficient way to design and import your menu graphics.  When you use this method, you lay out your entire 
menu structure in a program such as Adobe Photoshop, then name each layer according to the DoStudio 
Authoring naming convention.  When you import the PSD into DoStudio Authoring, each layer is assigned 
to a menu element according to the naming convention.  For details about importing a layered PSD file, see 
"Importing menu graphics in Mosaic" on page 85.

Video and audio encoding
DoStudio Authoring supports all three video codecs that are supported by the Blu-ray Disc specification: 
MPEG-2, SMPTE VC-1, and H.264/AVC.  Your video must be encoded as a valid Blu-ray Disc-compliant 
elementary stream for it to mux successfully.

DoStudio Authoring does not include an encoder.  DoStudio Encoder includes a Blu-ray compliant MPEG-4 
AVC encoder.

We have published a paper on our website that lists the current encoders that work with DoStudio 
Authoring: http://www.netblender.com/main/resources/wikipapers/blu-ray-encoding/
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The following video codecs are supported by the Blu-ray Disc specification:

 n MPEG-2 is the venerable codec that we have worked with in standard DVD for over a decade. There 
are many reliable MPEG-2 encoders that can output a compliant HD stream. The downside of 
MPEG-2 is that it is not nearly as efficient as VC-1 or AVC, so it requires higher data rates (and 
larger file sizes) to achieve similar quality results. Most of the initial Blu-ray Disc releases were 
MPEG-2; however, very few new Blu-ray Disc titles use this codec.

 n SMPTE VC-1 is a new standard that is based on the Windows Media 9 codec from Microsoft. VC-1 
is more efficient than MPEG-2 and can achieve high quality results in the 15 Mbps range.

 n MPEG-4 AVC is the newest of the three codecs and is the most advanced. It is also the favored 
codec for Blu-ray Disc. AVC encoded streams can often achieve the same quality of MPEG-2 at one 
half the data rate.

Subtitling
DoStudio Authoring supports graphics-based subtitles for Blu-ray Disc.  The subtitle files are a series of 8-bit 
PNGs with an accompanying XML file in .dost format.  Several tools export .dost directly. For more 
information, see "Subtitles" on page 59.

Authoring
After creating your graphics and encoding your video, you are ready to author your Blu-ray Disc. The 
section "Working with DoStudio Authoring" on page 29 details the following authoring activities:

Disc setup

Disc setup involves specifying the BDCMF formatting requirements, disc and organization IDs, and other 
details.

Menu creation

Professional Blu-ray Disc titles feature pop-up menus that can float over the video playing in the 
background.  In DoStudio Authoring, you import your menu element graphics and use actions to assign 
navigation interactivity such as showing and hiding various menus and playback behaviors such as playing 
or pausing a chapter.

Playlist setup

Setting up your Blu-ray Disc playlist is not unlike setting up your title and chapter structure for a DVD.  Using 
DoStudio Authoring, you import your primary video and audio elements and assign them to a title.  If your 
title has chapter points, you enter those as timecode numbers.

Compile your Blu-ray Disc

With your menus authored and your video structure organized in your playlist, you are now ready to 
compile your Blu-ray Disc.  The compile process is simple. You click the Compile Blu-ray Disc button and 
DoStudio Authoring then writes out the HDMV and BD-J code that will comprise your final disc.
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Emulation/testing
Blu-ray Discs involve greater interactive capabilities than DVD so it is more important than ever to test your 
menus and playback behavior. We recommend testing your compiled Blu-ray Disc image in a computer 
based software player such as Corel WinDVD or ArcSoft TotalMedia Theatre. WinDVD and TotalMedia 
Theatre are fully compliant Blu-ray Disc players, so you can test your menus and video playback with 
confidence. When you are satisfied with your disc, it is advisable to burn several test discs and test them in 
several set-top Blu-ray Disc players.

Formatting
The final stage of the Blu-ray Disc authoring process is formatting.  In DoStudio Authoring, you simply click 
the Format Blu-ray Disc button to create the BDCMF image that Blu-ray Disc replicators require.  Most disc 
images are being shipped to replicators on hard drives (due to the size of the files) as of this printing; 
however, it is advisable to discuss this with your replicator.
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The DoStudio Authoring workspace
DoStudio Authoring offers a flexible workspace environment that can be adapted to a single or multiscreen 
setup.

The tabbed view
By default, DoStudio Authoring opens in a single screen tabbed view.  You can adjust the size and location 
of the tabbed spaces using drag-and-drop actions.

Floating workspace view
You can undock the tabs in the interface by double-clicking them.  An undocked workspace element 
appears as a resizable window that you can drag to the location and size of your choice.  The floating 
workspace is best for multidisplay settings.

You can dock the windows by dragging them over another window and releasing the mouse cursor over the 
desired compass point.

Chapter 4
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Layouts
DoStudio Authoring lets you save your favorite window arrangements.  We call these layouts.  You can save 
multiple layouts so if you have multiple authors using the same system, they can each save their own.  To 
save a layout, arrange the windows to your liking and choose Window > Save Layout.  The Window menu 
also lets you set a layout as the default arrangement, or you can reload the default DoStudio Authoring 
tabbed arrangement.

Overview of the workspace
Navigating the workspace in either display mode is quite simple.  The Menu Elements window and Playlist 
window are tree view windows that display the organizational layout of your disc elements.  You can 
collapse and expand the nested items in the tree view by toggling the Expand and Collapse buttons next to 
the element.  When you want to add or delete any element from your project, you do so in one of these 
windows.  Likewise, if you want to select any element in your project for editing, you should select it in one 
of these two windows.

The Layout Editor window and the Layout Preview window display the menus you have built.  To view menu 
elements in the Layout Editor and Layout Preview windows, select the check box next to the element in the 
Menu Elements window.  You can select menu elements and edit the layout of your menu elements by 
dragging them in the Layout Editor.  You can select menu elements in the Layout Preview window by 
clicking them but you cannot move them.

The Control Panel displays the editable parameters for any item you have selected.  The parameters are 
always relevant to the selected item.  For example, selecting a menu block in the Menu Elements window 
displays the animation settings and other properties for the menu block in the Control Panel.  Then when 
you select a button in the Menu Elements window, the Control Panel displays the image settings, remote 
control assignment, and other items specific to the button.

Let's look at each window in more detail.  The screen shots will be presented in the floating workspace view, 
but the same instructions apply when you are working with the windows in tabbed view.
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Working with the Menu Elements window
The Menu Elements window is not available for DSA EX Edition projects. For more information, see 
"Creating projects" on page 29.

When you start a new project, the Menu Elements window is empty.  To add an element, right-click the 
window to display a shortcut menu.  The shortcut menu will vary depending on what elements you have 
already added to your project, as well as what element you right-click or what element is selected when you 
right-click in a blank part of the window.  Right-clicking a blank space in the window will always give you 
the available options for adding a menu block.

DoStudio Authoring is optimized for importing your menu elements from a layered PSD file.  You can 
add, edit, and delete individual menu items using the Menu Elements window in DoStudio Authoring, 
but  you will usually find that it is most efficient to create and edit your menu elements in a program 
such as Adobe Photoshop and then import the PSD file into DoStudio Authoring.

The Menu Elements window also determines whether an element is visible in the Layout Editor.  To turn on 
visibility, select the check box to the left of the element's name.  To turn off visibility, clear the check box to 
the left of the element's name.  Only one set can be visible at a time, so turning on a set's visibility will 
automatically hide another set in the menu block that was already visible.

You can reorder the elements in the tree view using drag-and-drop actions.  The top button in a set is 
considered the default button.  This is important because in a few instances, the default button will be 
highlighted when a menu is displayed during playback.

To select an item for editing, click it once in the tree view.  This will display the element's editable properties 
in the Control Panel.  It will also highlight the element in the Layout Editor if the element's visibility is on.

You will see that buttons contain nested elements for each of the corresponding remote control options: 
Enter Key, Up Key, Down Key, Left Key, and Right Key.  These are event elements. Select these elements to 
add actions to your buttons.  They also contain an element called On Show, which allows you to add actions 
that occur any time the button appears on screen.
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When you have added actions to an element, a small red circle with a number in it appears on the element's 
icon.  This is a visual indicator of how many actions are assigned to an element.

You can copy and paste actions that you have assigned to menu elements.  For more information, see 
"Assigning and removing actions" on page 103.

Automatically assigning remote control navigation to buttons

You can quickly assign the remote control navigation by right-clicking the set in the Menu Elements 
window.  Click Apply Vertical Navigation or Apply Horizontal Navigation depending on the visual 
orientation of the buttons in the set.  For more information, see "Menu element properties" on page 41.
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Working with the Playlist window
The Playlist window displays a tree view  outline of the video layout of your Blu-ray Disc™.

The Playlist tree defines the structure of the audio/video assets on your disc, as well as several setup items.

The Playlist tree is a series of nested trees.  Click the small arrows to the left of the icons to expand a node to 
see the nested elements.  Right-click elements in the tree to add or remove items.  To select an item to edit its 
properties, click the item in the Playlist tree to display the item's editable properties in the Control Panel.

The audio/video assets are contained in the Audio Video Segments, Playlists, and Blu-ray Disc Titles nodes.

The Disc Information node contains setup information for your disc.  For more information, see "Setting up 
your project" on page 31.
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Working with the Layout Editor window
The Layout Editor displays your menus and allows you to edit their location on screen.  To move an item, 
click the item with your mouse and drag it to the desired location.  You will notice that when you select an 
element in the Layout Editor that it also highlights the element in the Menu Elements window and its 
editable properties are displayed in the Control Panel.

The Layout Editor is always displayed at 100 percent size (1920 x 1080 pixels).  There is no zoom level 
view.  If you want to see your entire menu in the Layout Editor, it is recommended that you set up 
DoStudio Authoring on a high-resolution, dual-monitor display configuration.
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Working with the Layout Preview window
The Layout Preview window is not available for DSA EX Edition projects. For more information, see 
"Creating projects" on page 29.

The Layout Preview window displays a scalable view of the layout of your menu elements.  The Layout 
Preview window always displays the entire canvas of your layout (the full 1920x1080 frame) and scales it 
to fit in the Layout Preview window.

You will notice that when you select an element in the Layout Preview that it also highlights in the Menu 
Elements window and its editable properties appear in the Control Panel.

Working with the Control Panel
The Control Panel displays the editable properties for any item you select in the Menu Elements and Playlist  
windows.  The properties displayed in the Control Panel will change depending on which item is selected.
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Working with DoStudio Authoring
Build a pop-up menu, set up your playlist, and compile and format a final Blu-ray Disc™ image ready for 
replication.

Creating projects
The first step in authoring your Blu-ray Disc is creating a DoStudio Authoring project file (.dsAp).

Starting a new project

 1. Choose File > New to start a new DoStudio Authoring project. You can also click the New Project 
button on the toolbar or press Ctrl+N.

If you are using DoStudio Authoring Indie Edition, continue to step 3.

If you are using DoStudio Authoring EX Edition, the Project Setup dialog box is displayed.

 2. Select your project type and click OK. The project type determines which menu features are available 
in the DoStudio Authoring workspace.

 n DSA Indie Edition: Select this option if you want to create a Blu-ray Disc with BD-J menus.

 n DSA EX Edition: Select this option if you want to create a Blu-ray Disc with HDMV menus.

 n Mixed Mode (Indie + EX): Select this option if you want both menu type options available, 
as in DoStudio Authoring 2.3 and earlier.

 3. Browse to the location where you want to save your project.

 4. Type a name for the project in the File name box and click Save to create the project and save it.

Now you can start authoring your Blu-ray Disc.

Chapter 5
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Changing your project type

You can change your project type at any time. To do so, click the Change Project Type button in the 
toolbar or click Change Project Type on the Window menu to display the Project Setup dialog box. Select 
your project type and click OK.

Saving and exporting projects
Choose File > Save to save changes to the current DoStudio Authoring project. You can also click the Save 
button on the toolbar or press Ctrl+S to save your project.

Exporting a copy of your project

Choose File > Export Project > Save to Folder to save the current project to a different location or with a 
new name.

Exporting your project to a .zip file

Choose File > Export Project > Save to ZIP to create a .zip file of your project. You can use this file to 
transfer your project to another computer. Simply unzip the .zip file and open the project file in DoStudio 
Authoring.

Files included in .zip Files not included in .zip

 n Menu file (.doml)

 n Playlist file (.dopl)

 n Movie Object file (.domo)

 n BD-ROM file (.dobl)

 n Configuration file (.docf)

 n Project file (.dsAp)

 n IG project files (.dlies)

 n PES menu files (.pes)

 n All images used in the menu

 n Loading screen image

 n Sound effect file

 n Audio files

 n Video files

 n Subtitle files

 n Subtitle images
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Setting up your project
This section describes the basic settings for your Blu-ray Disc project. While all of these settings are 
appropriately called "setup," it does not mean that all of these settings need to be completed as the first 
step in the authoring process. Many of these settings can be edited at any point in the authoring process 
prior to formatting your final disc image.

This section will guide you through each setup window and describe the editable parameters for each 
window.

Asset management

It is advisable that you set up a folder on your computer called DSA Projects and create a folder for each 
Blu-ray Disc project within the DSA Projects folder. All of your project assets must be contained in the 
project directory. For organizational purposes, we suggest that you create subfolders for images, 
audio/video assets, and subtitles. A sample directory structure would look like this:

During the authoring process, DoStudio Authoring will create a folder in the project's root folder called 
projectname.content and when you compile your project DoStudio Authoring will create a folder called 
projectname.BD that contains the compiled disc image.
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Disc Information

To edit your disc information, click the Disc Information button in the toolbar, or click the Disc 
Information node at the top of the Playlist tree.

The editable properties are displayed in the Control Panel.

Properties tab

Item Description

Disc ID The Disc ID is a unique identifier for each Blu-ray Disc title. A default 
value is entered when you start a new project. Click the Gen button to 
generate a new Disc ID when you start a new project, or at any time 
before replicating your disc.

The Disc ID is not your ISAN code, if you have chosen to apply for 
one. For more information on ISAN codes, please see the "AACS for 
Independent Producers" wikipaper: 
http://www.netblender.com/main/resources/wikipapers/aacs-for-
independent-producers/.

This item is not available for DSA EX Edition projects. For more 
information, see "Creating projects" on page 29.
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Item Description

Multiplex Audio/Video Select Yes if you want to multiplex audio, video, and subtitles when 
you compile your Blu-ray Disc. You must select Yes the first time you 
compile your project.

Select No if you want to compile only your BD-J code and reuse a 
previous mux. For more information, see "Compiling your Blu-ray 
Disc" on page 63.

Organization Number The organization number is a unique ID that represents the studio 
creating the disc. The organization ID that is chosen should be used 
on every disc created by that studio. The organization ID is a number 
between 2147418113 and 2147483647. This number is required by 
the Blu-ray Disc specification. The number is not managed by any 
central agency at this time; it is simply up to you to pick a number at 
random and use the same number for all of your projects.

This item is not available for DSA EX Edition projects. For more 
information, see "Creating projects" on page 29.

Application Number The application number is the ID for the particular title being 
authored. It is a number between 16384 and 32767. It is a good idea 
to generate numbers for your projects in some logical order. This 
number is different from your Disc ID number and is required by the 
Blu-ray Disc specification.

This item is not available for DSA EX Edition projects. For more 
information, see "Creating projects" on page 29.

Disc Output Folder Choose the folder where your compiled Blu-ray Disc resides by 
clicking the Browse button. DoStudio Authoring writes the compiled 
image to a folder called projectname.BD in the project's root folder.

Choosing the right output folder is very important for your disc to be 
replicated without errors.

 n Make sure the hard drive you are formatting to has at least 
100 GB of space for a BD-50 and 50 GB of space for a BD-
25.

 n It is highly recommended that you choose a folder that does 
not have any files or folders in it.

 n The hard drive you are using for your output folder must be a 
Windows NTFS drive.
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BDCMF tab

You do not need to complete the BDCMF tab when you begin your project. Instead, you can complete the 
information prior to formatting your final disc image for replication. If your project will not be sent to a 
replicator, you do not need to complete this tab at all.

BDCMF is the mastering format that replicators use to create Blu-ray Disc metal masters. DoStudio 
Authoring formats your final Blu-ray Disc image in the industry standard BDCMF 1.02 format used by 
replicators.

Item Description

Output Folder Choose the folder where your cutting master files will be stored by 
clicking the Select button.

Disc Label Type the name of the disc in the Disc Label box.

Master Id The Master Id and Version are optional boxes and do not have to 
conform to a specific format. If you are authoring for a larger 
facility, they may supply you data for these fields. If you are an 
independent production facility, it is up to you whether to make use 
of them.

Version

Copyright Notice Type the name of the copyright holder in the Copyright Notice box 
and the name of the content owner in the Owner Notice box. As you 
would expect, these are often the same organizations.Owner Notice

Location Type the location, name of the authoring facility, and the operator 
names in the respective boxes. These boxes are optional.Facility

Operator
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Item Description

Region A Select if the disc should be playable in the three regions specified in 
the Blu-ray Disc specification. The options are Allowed (disc plays in 
that region), Prohibited (disc will not play in that region), and Not_
Applicable (region free).

 n Region A includes the Americas, East and Southeast Asia, U.S. 
territories, and Bermuda.

 n Region B includes Africa, Europe, Oceania, the Middle East, 
the Kingdom of the Netherlands, British overseas territories, 
French territories, and Greenland.

 n Region C includes Central and South Asia, Mongolia, Russia, 
and the People's Republic of China.

These items are not available for DSA EX Edition projects. For 
more information, see "Creating projects" on page 29.

Region B

Region C

BCA Enabled Select this check box if you want the ISAN number printed in the 
Burst Cutting Area (BCA) of the Blu-ray Disc. This setting applies only 
if you are using Managed Copy.

Invalid Region JPEG If you plan to restrict one or more regions from playing the disc, 
you'll need to create an invalid region JPEG image. The purpose of 
this image is to inform the viewer of the disc that his or her Blu-ray 
Disc player cannot play this title because it is not in the correct 
region. You can make this image to be anything you'd like. The only 
requirements are that the image is 1920 x 1080 and it is a JPEG 
image.

This item is not available for DSA EX Edition projects. For more 
information, see "Creating projects" on page 29.
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Item Description

ISAN Number AACS Managed Copy allows the viewer to move content from the 
Blu-ray Disc to his or her computer, server, or a mobile device. The 
digital rights management of this content is handled via the Internet, 
so an AACS protected disc contains a link to a specific Managed 
Copy server. The Blu-ray Disc can also provide links to additional or 
related content via this link.

If you want to implement Managed Copy, you must enter a valid 
URL for the managed copy authentication server. Because the 
requirements for a managed copy server are not yet published by the 
AACS LA, many studios are entering URLs that will redirect to a 
managed copy server at some point in the future. NetBlender offers a 
managed copy solution that will meet the AACS LA requirements. 
Please visit the NetBlender website for more details.

In July 2010, the AACS LA declared that ISAN codes are optional for 
Blu-ray Discs; however, you will need one if you plan to implement 
managed copy.

Details on obtaining an ISAN number can be found here: 
http://www.netblender.com/main/resources/wikipapers/aacs-for-
independent-producers/

Managed Copy URL

Files and Groups tab

Button Description

Import Audio To add audio files such as button sound effects to your menus you 
must first import the files into your project. Click the Import Audio 
button and browse to an audio file. DoStudio Authoring can import 
uncompressed .wav files and LPCM .wav files.

The Blu-ray Disc specification limits the total size of the 
included audio files to 4 MB.

Remove Select an audio file in the list and click the Remove button to remove 
the file from your project.

Audio File Source The Audio File Source box displays the file path and name of the 
selected audio file. Click the Browse button to choose a different file.
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Button Description

New Click the New button to add a Sticky Button Group to your project.

Sticky Buttons Groups are a feature unique to DoStudio Authoring. 
Sticky Button Groups are used for buttons that need to retain their 
setting when the menu is hidden. A practical example of a sticky 
button would be a language setting button. If the viewer selects 
French as the preferred audio track, he or she will expect to see that 
button still selected when they use the menu again. Buttons that are 
not assigned to a Sticky Button Group return to their normal state 
when the menu is hidden. For more information, see "Button 
properties" on page 43.

You can create as many Sticky Button Groups as you choose, but in 
real-world terms your project will only require a few such as Audio 
Settings, Subtitles Settings, and Chapter Selection.

Sticky Button Groups work in conjunction with the "Associate this 
button with…" actions that you apply to the On Show event of a 
button. For more information, see "Button association actions" on 
page 105.

Sticky Button Groups are not available for DSA EX Edition 
projects. For more information, see "Creating projects" on page 
29.

Remove Select a Sticky Button Group in the list and click the Remove button 
to remove it from your project.

Advanced Parameter Tab

The Advanced Parameter tab displays a list of Advanced Parameters (APRMs) that you have created for 
your project. In this window, you can add and remove APRMs using the New and Remove buttons.

This tab is not available for DSA EX Edition projects. For more information, see "Creating projects" on 
page 29.

For more information about APRMs, see "Advanced authoring" on page 131.
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Validation window

The Validation window allows you to check for errors before you compile your project. The validation 
process is identical to the process that is run when you click Compile or Quick Compile.

Validation performs an image buffer verification that checks the size of your menu graphics and displays 
the total amount of the Image Buffer that your project is using. If you have exceeded the 32.5 MB allowed 
by DoStudio Authoring, you will receive a warning.

Validation also checks for errors that will occur due to missing assets in your project or actions that 
reference missing or erroneous project elements. For example, if you have added a Show Submenu Action 
that references a menu element that has been deleted, the validation will notify you of the error. Likewise, if 
a video or audio asset has been moved or deleted, the validation will notify you that the asset's path in the 
playlist is erroneous and must be fixed.

Finally, the validation process checks for errors in your movie object commands. For more information, see 
"Using the Movie Object Editor" on page 142.

Language node

The Blu-ray Disc specification allows you to define different language settings for your disc's name, the 
name of each title and chapter in your disc, and an onscreen display icon. Currently, only the Sony 
PlayStation®3 supports the onscreen display icon, but other players will likely support this in the future. No 
players currently support the display of the title and chapter names in multiple languages, but this will likely 
be supported as the Blu-ray Disc format matures.

This version of DoStudio Authoring allows you to set one language setting.
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To edit the language settings, expand the Disc Information node in the Playlist tree and select the language 
node. The language properties are displayed in the Control Panel.

Item Description

Disc Title Name The Disc Title Name is the same as the name you have designated in 
Disc Information.

Language You can select the language from the list in the combo box.

Total Number Of Discs 
In Set

These Total Number Of Discs In Set and This Disc Number In Set 
boxes are optional.

This Disc Number In 
Set

Copyright The Copyright box should be completed with the name of the 
copyright holder.

Small Image (JPG) The Small Image and Large Image boxes are optional. They allow 
you to specify a disc icon image for use with onscreen displays on 
Blu-ray Disc players. Currently, only the Sony PlayStation®3 supports 
the use of this image. The images must be in JPEG format (.jpg) in 
the appropriate pixel sizes. The small image is 416 x 240 and the 
large image is 640 x 360.

Large Image (JPG)
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BD-ROM node

In some cases you might want to include additional computer files on your Blu-ray Disc. DVD authors 
understand this concept as adding "ROM" material to a DVD. There is no official term for this in the Blu-ray 
Disc specification; however, you are allowed to add folders and files to your disc. You can include any type 
of computer file.

To do this, expand the BD-ROM node in the Playlist tree. You will see that three folders already exist: BDMV, 
AACS, and CERTIFICATE. These folders make up a standard Blu-ray Disc that plays video.

To add an additional file to the root of your disc, right-click the BD-ROM node in the Playlist tree and click 
Add File. Browse to the file on your computer (it can be located anywhere on your workstation) and click 
Ok. You will now see the file listed in the tree.

To add an additional folder to your disc, right click on the BD-ROM node in the Playlist tree and click Add 
Folder. You will now see the folder listed in the tree.

You can rename the folder by typing a new name in the Control Panel or by selecting the folder in the tree 
and pressing F2. You can add files to a folder by right-clicking the folder and clicking Add File.
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Menu element properties
After you have imported your menu graphics, you can fine tune their location on screen using the Control 
Panel.

For more information about importing menu graphics, see "Importing menu graphics in Mosaic" on page 
85.

Menu block properties

To view a menu block's properties in the Control Panel, select the menu block in the Menu Elements tree.

Item Description

Editing Element Type a new name in the Editing Element box to rename the menu 
block.

Background Click the Browse button to select a background image for the menu 
block.

Make Background 
Transparent

Select the Make Background Transparent check box if you want the 
menu block to have a transparent background.

Top and Left You can reposition a menu block by typing new values in the Top and 
Left boxes. In most cases, you will not need to do this because you 
can determine the precise location of the menu blocks when 
designing your Photoshop file.  There are instances when dealing with 
odd-shaped menu blocks, or other menu blocks whose background 
image does not fill the entire menu block area, where the ability to 
make fine adjustments to its position is required.

Note regarding the placement and animation of multiple menu 
blocks:

You are allowed to create multiple menu blocks in your project. 
A practical example of this would be to have one menu block 
for chapter selection, another for special features, and perhaps 
a third for disc setup options. Visually, it is often desirable to 
position the menu blocks to appear in the same area of the 
screen and animate on and off.

When authoring a project that involves multiple menu blocks 
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Item Description

that appear in the same part of the screen, the responsibility is 
on you, the author, to author your animation actions in such a 
way that the menu blocks never overlap on screen at the same 
time. For example, if one button on your Main Menu displays 
the menu block that shows the chapter selection, and another 
button on the Main Menu displays the menu block that contains 
the special features, you must be sure that the chapter selection 
is always hidden before the viewer can select the special 
features and vice versa. If you allow both menu blocks to 
appear in the same location on screen at the same time this can 
cause erratic playback behavior such as one menu block erasing 
part of the menu block that it overlaps.

Width and Height If you are using a background image, the width and height of the 
menu block are determined by the image and cannot be edited in the 
Control Panel.

If you selected the Make Background Transparent check box, you 
can change the size of the menu block by typing new values in the 
Width and Height boxes.

On Show and On Hide events for menu blocks

Under each menu block in your tree, you will see two icons: On Show and On Hide. These are a special type 
of event to which you can assign actions. The On Show event executes the actions assigned to it any time 
the menu block appears on screen. Conversely, the On Hide event executes every time the menu block is 
hidden.

Animation actions can be assigned to the On Show and On Hide events that animate the menu block on 
and off screen. For more information, see "Animation actions" on page 129.
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Set properties

Often, you will design a menu that requires more buttons than you can reasonably fit onscreen at one time. 
A practical example of this would be a chapter selection menu in which you have 25 chapters to choose 
from. While you could place all 25 chapter icons in your menu block, it might be desirable to break them 
into smaller groups and display the groups individually. This is what sets are designed to do.

A good way to think of sets is as layers of your menu block that are stacked on top of each other. Each set 
contains its own set of buttons and each set can contain its own background image or it can be 
transparent. Only one set can be visible at a time.

By default, every menu block has one set. Your menu blocks can have an unlimited number of sets.

To view a set's properties in the Control Panel, select the set in the Menu Elements tree.

As you can see in the screen shot above, the properties for a set are similar to the properties for a menu 
block. If the set has its own background image, it is reflected in the Properties tab. As with menu blocks, 
you can update the image using the Browse button.

If the set is transparent, the Make Background Transparent check box will be selected. When a set is 
transparent, the background image of the menu block will be visible. If the menu block is also transparent, 
then the buttons contained in the set will appear to float directly over the video.

The position and size of a set are determined by the position and size of the menu block. If you change the 
background image and it is not the same size as the menu block and set, you will be prompted that 
selecting the new image will change the size of the menu block.

Button properties

In Blu-ray Disc authoring, unlike with DVD, button images are comprised of three images corresponding to 
three states that buttons can have: normal, selected, and activated. When you import a layered Photoshop 
file, Mosaic creates a separate PNG file for each of the button states. For more information, see "Importing 
menu graphics in Mosaic" on page 85.

To view a button's properties in the Control Panel, select the button in the Menu Elements tree.

WORKING WITH DOSTUDIO AUTHORING           43   



Button Properties tab

Item Description

Editing Element Type a new name in the Editing Element box to rename the button.

Normal Click the Browse button to select an image file for the normal state 
of the button.

Click the Delete button  to remove the image file for the normal 
state of the button.

Your button must have a graphic for at least one of the states. 
Most buttons have at least a normal state and a selected state. 
If you leave the selected and activated states empty, then your 
button will be displayed in the normal state regardless of 
whether it receives focus or not. This saves space in your image 
buffer. You are allowed to leave the normal state empty and 
only have a graphic for the selected and activated states.

Selected Click the Browse button to select an image file for the selected state 
of the button.

Click the Delete button  to remove the image file for the selected 
state of the button.

Activated Click the Browse button to select an image file for the activated state 
of the button.

Click the Delete button  to remove the image file for the 
activated state of the button.

Top and Left You can reposition a button by typing new pixel values in the Top 
and Left boxes. In most cases, you will not need to do this because 
you can determine the precise location of the buttons when 
designing your Photoshop file.

Width and Height The size of a button is determined by the size of the largest image 
used for the button states.
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Item Description

The button state images do not need to be the same size. 
DoStudio Authoring will take the largest image and make that 
the size of the button. Smaller images will be centered in the 
button area.

You should position your buttons so that they do not overlap 
each other. Overlapping the buttons will cause the menu 
buttons to appear cut off.

Sticky Group Select a Sticky Button Group to assign to this button. Sticky Button 
Groups are created on the Files and Groups tab in Disc Information 
Control Panel. For more information, see "Files and Groups tab" on 
page 36.

Remote Control tab

You must assign the remote control navigation properties for each button in your menu. You do this in the 
Remote Control tab.

Using the lists for each of the directional arrows, select which button should be highlighted when the viewer 
clicks the directional arrow. The lists include all buttons in your project. If you want to delete remote control 
navigation from an arrow button, simply select the blank setting at the top of the list.

Automatically assigning remote control navigation

You can quickly assign remote control navigation by right-clicking the set in the Menu Elements window 
clicking Apply Vertical Navigation or Apply Horizontal Navigation depending on the visual orientation of 
the buttons in the set. DoStudio Authoring will automatically assign the remote control navigation based on 
the order of the buttons in the set according to your selection. In other words, you must arrange your 
buttons in the Menu Elements tree in the same order that they appear onscreen in order for the automatic 
remote control assignment to work.

Apply Vertical Navigation assigns remote control commands to the up and down buttons, while Apply 
Horizontal Navigation assigns remote control commands to the left and right buttons. The assignment is 
based on the order of the buttons in the Menu Elements tree, not on the actual visual layout of the buttons 
onscreen. It is acceptable to apply both vertical and horizontal navigation to the buttons if you so desire.
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Assigning actions to buttons

To assign an action to a button, expand the button view by clicking the arrow next to the button in the 
Menu Elements tree. This expands the tree to display the Enter Key, Up Key, Down Key, Left Key, Right Key 
and On Show event for the button you have selected.

To assign an action to a button, you must assign the action directly to the desired key in the tree. When you 
select one of the keys, the actions window appears in the Control Panel. For more information, see "Using 
actions" on page 103.
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The On Show event for buttons

The On Show event allows you to assign an action that will execute any time the button appears on screen. 
In most cases, you will apply one of the "Associate this button with…" actions to the On Show event.

The "Associate this button with…" actions cause the display behavior of the button to vary depending on 
what audio track, subtitle track, or chapter is currently playing. This allows you to easily add "smart 
selections" to your menus without having to set a lot of conditions.

For more information, see "Button association actions" on page 105.

Setting up your playlist
This section describes the process for setting up the video playback organization of your Blu-ray Disc, which 
is contained in the Playlist tree.  Setting up your Playlist tree involves creating audio/video segments and 
adding your elementary video, audio, and subtitle streams; creating playlists; adding chapters to path items 
in your playlists; editing the user operations for each playlist; and setting up the loading screen and the 
arrangement of your playlists in your title.  If you are using the optional 3D or BDJO features of DoStudio 
Authoring, you will set up those features in the Playlist tree as well.

The Playlist Tree is displayed as an expandable tree menu.  The Playlist contains the following elements: 
Disc Information, BD-ROM, Audio/Video Segments, Playlists, and Blu-ray Disc Titles.
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For more information about the Disc Information and BD-ROM nodes, see "Setting up your project" on 
page 31.

When you start a new project, the Playlist tree contains one empty 2D audio/video segment and the 
DoStudio BD-J Menu title.

Overview of the DoStudio Authoring Blu-ray Disc playlist structure

It is useful to examine the playlist structure from a high level before diving into the details.  The DoStudio 
Authoring Blu-ray Disc Playlist structure is comprised of three types of elements: audio/video Segments, 
playlists, and titles.

Audio/video segments

Segments are your actual video elementary streams.  If you have audio and subtitles, they are associated 
with the video streams in the segment.  To create a slideshow, you add a series of still images to create a 
slideshow segment.

You must add your elementary streams as segments in your project before you can author how they should 
play back on your disc.  Your segments are reusable in your project, so you can add them to multiple 
playlists without taking up any extra space on the disc.  No matter how many times you add a segment to a 
playlist in your project, it is only multiplexed once.

For more information, see "Audio/video segments" on page 71.

Playlists

Playlists define how your video will play on your Blu-ray Disc, and how your video will interact with your 
menus.  You add one or more segments to a playlist (they are called path items once they are added to a 
playlist), add chapters to the path items, control user operations during playback, and add actions.  Most of 
your authoring in the Playlist tree is directed to the playlists.

You can add up to 999 playlists to your project.  You can add your segments to different playlists as many 
times as you want.  They are essentially text files that take up very little space on your Blu-ray Disc, so you 
can use them freely to create randomized playback, Play All features, and more.

For more information, see "Playlists" on page 49.

Blu-ray Disc titles

Blu-ray Disc Titles are the parent element for your playlists.  Your DoStudio Authoring project starts with one 
title called DoStudio BD-J Menu.  You will define the disc startup procedure for the DoStudio BD-J Menu title 
by placing playlists in the title and determining the location of the BD-J loading screen.  You can add more 
titles only if you have purchased DoStudio Authoring EX Edition.

For more information, see "Blu-ray Disc titles" on page 57.
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Playlists
Playlists are the heart of the Playlist tree. Your project starts out with no playlists, so let's begin by adding 
some. There are two methods for creating playlists.

Creating playlists with drag-and-drop

 1. Right-click Playlists in the Playlist tree, and then click Add Playlist.

 2. Select the new playlist to display its timeline in the Control Panel.

 3. Drag  segments from the Playlist tree to the timeline to add segments to the playlist.

Creating playlists from segments

Right-click a segment in the Playlist tree, and then click Create Playlist from Segment. A new playlist 
containing the segment is added to the Playlists folder.

Adding segments to existing playlists

Right-click a segment in the Playlist tree, click Add Segment to Playlist, and then click the name of the 
playlist to which you want to add the segment. The segment is added to the end of the playlist.

Playlist properties

Select a playlist in the Playlist tree to displays its properties in the Control Panel.

Item Description

Name Rename the playlist by typing a new name in the Name box.

Number Each playlist must have a unique number. DoStudio Authoring gives 
your first playlist the number 1000 and each new playlist increments 
by one integer (1001, 1002, 1003, etc.) We recommend not changing 
these numbers unless you are creating custom BD-J applications with 
the BDJO module.

On End Play Use the On End Play list to select the playlist to play next.

Notes:

 n If you add a Play Playlist action to the End event of the 
playlist, the Play Playlist action will take priority over the 
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Item Description

On End Play event and the On End Play event will not 
execute.

 n The On End Play setting is not available for DSA EX 
Edition projects. For more information, see "Creating 
projects" on page 29.

Bypass Lossless Audio Select the Bypass Lossless Audio check box to give priority to lossless 
audio tracks (DTS-MA, Dolby TrueHD, LPCM) if the Blu-ray Disc 
player can play the lossless audio.

Interactive Audio 
Mixing

Select the Interactive Audio Mixing check box to mix button sound 
effects with the segment's primary and secondary DTS and/or Dolby 
audio tracks when you multiplex your disc. We recommend keeping 
this check box selected.

The playlist timeline

When you add segments to a playlist, they are displayed in a timeline view. The visual order of the 
segments from left to right determines the playback order of the segments in the timeline. In many cases 
you will have only one segment per playlist.

To delete a segment from a playlist, click the black X in the upper-left corner of the segment. To reorder the 
segments in a playlist, click the top of the segment icon and drag it to a new location.

Seamless and nonseamless connections

When you add more than one segment to a playlist, you can join them seamlessly so that the disc will play 
smoothly from one segment to the next without dropping to a black screen. To make a seamless 
connection, click the red connection indicator to toggle it to green.

Simply choosing to make a seamless connection does not guarantee that the connection will play without 
dropping to black. Whether your connection will play as a seamless connection depends upon a number of 
factors.
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Here are the requirements for a seamless connection:

 n Segment audio must be exactly the same duration as the video

 n The bit rate of the connecting video segments must be within 5 Mbps  of each other at the time of 
the connection

Playlist Start and End event

The Start and End events are not available for DSA EX Edition projects. For more information, see 
"Creating projects" on page 29.

Each playlist has a Start and End event in the Playlist tree.

Select these elements to assign an action that will occur at the start or end of the playlist's playback. When 
you select these elements in the Playlist tree, the Action List appears in the Control Panel.

A practical example of a playlist start action would be to assign the Show Menu Block action to the 
beginning of a playlist that will be the video loop that appears when the disc plays.

Actions that are assigned to the Start event of a playlist will execute any time the playlist is played, whether 
or not the playlist is played from the beginning. For example, if you jump directly to a chapter that occurs 
five minutes into the playlist, the Start event actions will still execute.
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Also, it is important to note that any Title Playback action that is assigned to the End event of a playlist will 
override the On End Play event that is defined in the playlist properties. For example, if you add a Play 
Chapter action to the End event for a playlist, the Play Chapter action will take priority over the On End Play 
event for the playlist.

Disabling user operations

Each playlist has its own settings for disabling certain remote control buttons. Select a check box to disable 
the user operation.

The basic user operations that can be disabled are Play, Pause, Fast Forward, Rewind, Next Chapter, 
Previous Chapter, Pop Up Menu, Primary Audio Stream #, Subtitle Language, and Subtitle Stream #.

If you have purchased the BDJO module, you can override additional advanced user operations:  Resume, 
Move Down, Time Search, Secondary Video #, Stop, Move Left, PIP Subtitle Language, Select/Activate 
Button, Activate Button, Move Right, Popup Off, Secondary Audio Enabled, Angle Number Change, Move 
Up, Popup On, Secondary Audio Stream #, Chapter Search, Select Button, Still Off, and Secondary Video 
Enabled.

The User Operations has a list of buttons in the Playlist tree. You can assign actions to any of these buttons. 
Selecting any of these button elements in the Playlist tree displays the Action List window in the Control 
Panel.

You cannot assign actions to remote control buttons in a DSA EX Edition project. For more 
information, see "Creating projects" on page 29.
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Remember that remote control button actions are specific to each playlist. For example, if you want a 
certain action to occur any time the viewer presses the red button on the remote control, you must assign 
the action to the red button in each playlist.

The buttons execute their normal behavior in addition to the actions you add to them unless you have 
disabled them in the user operations settings.
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Path items

When you add a segment to a playlist it becomes a path item. You can see the path items nested in the tree 
under each playlist.

Adding chapters to path items

Chapters are defined as a timecode start point within a path item. To add a chapter to a path item, expand 
the Playlist tree to see the chapters icon. Right-click Chapters, and then click Add Chapter. A new chapter is 
added to the path item.

Select the chapter to edit set its timecode value in the Control Panel. You must enter the timecode value for 
the chapter start in the form hours:minutes:seconds:frames. The first chapter in a title will most likely have 
the timecode value 00:00:00:00.
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Each new chapter is named sequentially as Chapter 1, Chapter 2, and so on. You can, of course, rename a 
chapter by typing a new name in the Name box in the Control Panel.

A path item can have up to 999 chapters. By default each path item has one chapter at timecode 
00:00:00:00.

Importing chapters from a Sony Vegas Pro XML file

You can import chapter markers created in a Sony Vegas Pro project into your DoStudio Authoring playlist. 
For more information about exporting your chapter markers from Vegas Pro to an XML file, see "Exporting 
chapter markers from Vegas Pro" on page 164.

 1. Right-click the Chapters element in your title, and then click Import Chapters from Vegas XML File.

 2. Browse to your XML file from Vegas Pro and click Open.

The chapter markers exported from Vegas Pro appear in the chapters list for the title.

Importing chapters from a Final Cut Pro XML file

You can import chapter markers created in a Final Cut Pro project into your DoStudio Authoring playlist. For 
more information about exporting your chapter markers from Final Cut Pro, see "Exporting chapter markers 
from Final Cut Pro" on page 165.

 1. Right-click the Chapters element in your title, and then click Import Chapters from FCP.

 2. Browse to your XML file from Final Cut Pro and click Open.

The chapter markers exported from Final Cut Pro appear in the chapters list for the title.

Importing and exporting chapters from a text file

You can import and export your chapters list from a simple text file. The text file should be formatted with 
one chapter entry per line. No header information is required. DoStudio Authoring will determine the frame 
rate from the video segment setting. The chapters should be formatted in non-drop format: HH:MM:SS:FF 
starting at 00:00:00:00.

Your text file should look like this:

00:00:00:00

00:03:10:12

00:14:03:06

00:20:06:00

Right-click the Chapters icon and choose Import Chapters from Text File. Your chapters will be named 
Chapter 1, Chapter 2 and so on. You can rename the chapters in the Control Panel after you have imported 
them.

To export your chapter list, simply right-click the Chapters icon for the Path Item and choose Export 
Chapters to Text File. This will create a .txt file.
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Copying and pasting chapters

DoStudio Authoring allows you to copy and paste a chapter list from one path item to another. This is 
useful if you are reusing a segment in multiple playlists.

 1. Right-click Chapters for the source path item, and then click Copy Chapter List.

 2. Right-click Chapters for the target path item, and then click Paste Chapters List.

Chapter Start action

Chapters have a Start element in the Playlist tree view.

Select the Start element to assign an action that will occur at the start of a chapter's playback. When you 
select these elements in the Playlist tree, the Action List appears in the Control Panel. For more information, 
see "Using actions" on page 103.

There is no option for a chapter End action because the end of a chapter is inherently either the start of the 
next chapter or the end of the playlist.
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Blu-ray Disc titles
By default, your DoStudio Authoring project contains one Blu-ray Disc title called the DoStudio BD-J Menu. 
All of your playlists are housed in this title so that your menu can be active across all of the video in your 
project.

If you have purchased the BDJO module you can create additional Blu-ray Disc titles and add custom BD-J 
applications to those titles.

Configuring the loading screen

This feature is not available for DSA EX Edition projects. For more information, see "Creating projects" 
on page 29.

You can choose what is displayed while the Blu-ray Disc player loads your BD-J menu. Depending on the 
profile, age, and general speed of the Blu-ray Disc player, this loading time can be very brief (1 second) or 
longer (upwards of 40 seconds).

Select the Blu-ray Disc Titles folder in the Playlist tree, and then select the Loading Screen tab in the Control 
Panel to configure the loading screen options.

Item Description

Loading Screen Select the type of loading screen for your Blu-ray Disc:

 n Back and Forth Animated Image

 n Blank Black Screen

 n Static Image

Image File If you selected Back and Forth Animated Image or Static Image, 
click the Browse button and choose your image file.

We recommend choosing a very small image for the Back and 
Forth Animated Image option.

Background Color If your image file is not 1920 x 1080, click the Browse button to 
choose a background color for your loading screen.

Top Position

Left Position

Set the location of the image on screen by typing values in the Top 
Position and Left Position boxes.
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Specifying the First Play and Top Menu titles

The Blu-ray Title Setup tab includes some important disc startup information. Most of this information is 
relevant only if you are using the 3D module or the BDJO module.

Item Description

First Play Title This determines which title plays when the disc is inserted in a player. 
Unless you have added a new Blu-ray Disc title (DoStudio Authoring 
EX Edition only), this will always be the DoStudio BD-J Menu title.

Top Menu Title This determines what is displayed when the viewer presses the Top 
Menu button on the remote control.

This setting is not available for DSA Indie Edition projects. For 
more information, see "Creating projects" on page 29.

BD 3D Initial Frame 
Rate

This should match the frame rate of your video.  The three options for 
BD3D are:

 n 23.98 (your video must be 1920 x 1080)

 n 50 (your video must be 1280 x 720)

 n 59.94 (your video must be 1280 x 720) 

BD 3D Initial 
Resolution

This should match the frame resolution of your video.  The two 
options for BD3D are:

 n 1920 x 1080 (your frame rate must be 23.98)

 n 1280 x 720 (your frame rate can be either 50 or 59.94) 

BD 3D Initial Display 
Mode

In most cases, if you are making a BD3D, you will want the start up 
mode to be 3D.  If this is set to 2D, your 3D video will display in 2D.

Number Enter a number to change the folder number and JAR file number. 
This number must be five digits.
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Subtitles
The Blu-ray Disc specification allows for two types of subtitles: image based and text based. DoStudio 
Authoring supports image-based subtitles.

DoStudio Authoring does not include a built-in subtitling application, so you must create your subtitle files 
separately and import them into your project. This section will describe the required format for subtitle files, 
recommended tools for creating subtitle files, and how to import them to your project.

The .dost subtitle format

DoStudio Authoring imports image-based subtitles and multiplexes them with your audio/video assets 
when you compile your project. The details of the subtitle format are quite simple, yet as any professional 
DVD author knows all too well, the task of successfully creating subtitles can be rather tedious.

DoStudio Authoring subtitles are comprised of a series of 8-bit .png files governed by a simple XML script. 
The XML script has the file extension .dost. The 8-bit.png files can be sized at 1920 x 1080 pixels, which is 
the full size of the HD Blu-ray Disc canvas or they can be smaller than the screen size and positioned using 
the XML. An author could create these images manually using the "Save for Web" feature in Photoshop 
(select PNG-8 128 dithered (indexed color)); however, there are far more efficient ways to accomplish this 
that will be detailed shortly.

The timecode in the .dost file must match the timecode of the title in DoStudio Authoring in order for the 
subtitles to display properly. A title's timecode always starts at 00:00:00:00.

The format for the .dost file is as follows:

Header information

The first three entries in the header must have the following values:

$FORMAT=480

$VERSION=1.2

$ULEAD=TRUE
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The only value that can change is the $DROP value. Here are the possible values:

$DROP=30000 (30 fps)

$DROP=29970 (29.97 fps)

$DROP=25000 (PAL frame rate)

$DROP=24000 (24p frame rate)

$DROP=23976 (23.98 fps)

$DROP=59940 (59.94 fps)

Body information

The NO column tells us the subtitle entry number is 001.

The In Time of the subtitle is 00:40:45:05.

The Out Time of the subtitle is 00:40:49:03.

The top X position of the subtitle image is 0 pixels.

The top Y position of the subtitle image is 0 pixels.

The image name is for this subtitle entry is fr_0001.png.

The image does not fade in because the Fade In value is 0.

The image does not fade out because the Fade Out value is 0.

Requirements

Currently the Fade In and Fade Out are not supported and must be zero.

The .png file must be 8-bit color depth.

The INTIME and OUTTIME match the frame rate in the header information.

Subtitling tools

Several tools now support export to .dost natively. As of this writing, Z Depth 2.1, TitleFactory 4.0, Lemony 
Pro, Subtitle Workshop 4, and Annotation Edit (Mac) support the .dost file format.
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Adding subtitle tracks to your playlist

After you have created your subtitle files as described above, you need to add them to your project. 
Subtitles are added to the Primary Audio/Video element in the Playlist tree.

 1. To add a subtitle track, right-click the Primary Audio/Video element in the Playlist tree and choose 
Add Subtitle from the shortcut menu.

 2. Click the Subtitle element in the tree and select a subtitle file (.dost) for the track in the Control 
Panel using the Browse button. You can add multiple subtitle tracks to a title.
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Subtitle properties

Item Description

Name The name of the subtitle track in DoStudio Authoring.

Language You can select the language display for the subtitle track using the 
Language list. This will display the language on screen or on the Blu-
ray Disc player front panel display if the player supports this feature.

Full Screen Images If your subtitle .png files are 1920 x 1080, select Yes in the Full 
Screen Images list.

If your subtitle .png files are smaller than 1920 x 1080 and their 
position is set in the .dost file, select No in the Full Screen Images list.

Subtitle Track # The subtitle track number. (Display only.)

Crop Subtitles Crop your full-screen subtitle images to only the size needed. For 
more information, see "Cropping subtitles" below.

Subtitle File The file path and name of the subtitle file. Click the Browse button to 
choose a different file.

Cropping subtitles

If you have full-screen 1920 x 1080 subtitle .png files, you can use the Crop Subtitles button in the Control 
Panel to crop the image files to only the size needed and modify the .dost file to use the new coordinates. 
Cropping your subtitles will save time when you compile your disc.

 1. Select a subtitle element in the Playlist tree to display its properties in the Control Panel.

 2. Click the Crop Subtitles button.

The DSA Subtitle Converter window is displayed with your .dost file in the Source DOST box.

 3. Click the Convert button to begin cropping the image files associated with the source .dost file.

When the process is complete, a new .dost file and cropped .png files are created in a subfolder 
named "cropped_dost" where the original .dost file is located. The Control Panel is also updated to 
use the new .dost file. Click the question mark button in the DSA Subtitle Converter window to open 
the .dost file in Notepad.
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Compiling your Blu-ray Disc
When your menus are authored and your playlist is set up it is time to compile your Blu-ray Disc. Compiling 
allows you to watch your Blu-ray Disc in a software player, such as WinDVD, or on a set-top player. The 
compile process is the step in which your menu elements, playlist organization, and primary audio, video, 
and subtitle files are written into a file structure that can be read by Blu-ray Disc players.

A compiled Blu-ray Disc folder can be burned to BD-R/RE using disc-writing software such as ImgBurn. For 
more information, see "Using ImgBurn" on page 159.

This section describes the compile process and the timesaving Quick Compile (multiplexer off) setting that 
allows you to reuse multiplexed audio/video files from previous compiles.

Compile operations

DoStudio Authoring includes three compile modes: Compile (multiplexer on), Compile 3D Disc as 2D Disc, 
and Quick Compile (multiplexer off).

Compile

When you compile your Blu-ray Disc, DoStudio Authoring verifies your project, multiplexes your video and 
audio, and writes the necessary binary files, transport streams, and BD-J code to create a compiled Blu-ray 
Disc image.

It is normal to compile your project numerous times throughout the authoring process. The first time you 
compile your project, you must use the Compile feature rather than Quick Compile.

To compile your Blu-ray Disc, choose Compile > Compile Blu-ray Disc, click the Compile Blu-ray Disc 
button on the toolbar, or press F5.
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The compile window logs the progress of the compile. It begins by preparing the assets and calculating the 
total graphics buffer size. Then it runs a validation process to check for missing audio/video assets and 
actions that have invalid parameters. The compile window notifies you when your Blu-ray Disc has 
compiled successfully. It will also notify you if there were errors during the compile process.

DoStudio Authoring writes out the compiled disc structure in a folder called yourprojectname.bd in your 
project's root folder. The compile window gives you an option to open the output folder to see the compiled 
files. The output folder contains two folders:

 n Compile

 n Disc

The Disc folder contains the compiled disc structure with the following directories:

 n BDMV

 n AUXDATA

 n BACKUP

 n BDJO

 n CLIPINF

 n JAR

 n META

 n PLAYLIST

 n STREAM

 n index.bdmv

 n MovieObject.bdmv

 n CERTIFICATE

 n BACKUP

 n AACS

When burning a BD-R/-RE, you burn the BDMV and CERTIFICATE folders to your disc. The AACS folder is 
empty until you format your disc for replication. You should not burn it to your BD-R/-RE.

Compile 3D Disc as 2D Disc

You can compile a 3D project to a 2D Blu-ray Disc by  choosing Compile > Compile 3D Disc as 2D Disc. 
You can also click the Compile 3D Disc as 2D Disc button the toolbar or press Shift+F6. Compiling your 3D 
project to a 2D Blu-ray Disc takes less time than compiling to a 3D disc, giving you more time for testing.
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Quick Compile

Quick Compile is not available for DSA EX Edition projects. For more information, see "Creating 
projects" on page 29.

The most time-consuming part of the compile process is the multiplexing of the video and audio. You have 
the option of turning multiplexing on and off to increase efficiency. This can be accomplished in two ways. 
At any time during the authoring process, you can choose Compile > Quick Compile, click the Quick 
Compile button on the toolbar, or press F6 to compile your menu navigation and actions without re-
multiplexing the video and audio.

Alternatively, you can set up the Quick Compile mode using the multiplexer setting found in the Disc 
Information properties. Click the Disc Information button on the toolbar to display the properties in the 
Control Panel.

Select Yes or No in the Multiplex Audio/Video list.

The first time you compile your Blu-ray Disc, Multiplex Audio/Video must be set to Yes (a full compile) so 
that the video structure defined in the Playlist tree can be generated and the elementary video and audio 
streams can be muxed into transport streams that are readable by Blu-ray Disc players.

For subsequent compilations, you can set Multiplex Audio/Video to No or click the Quick Compile button.

You would use Quick Compile if you have made edits to you menu authoring but you have not made any 
changes to your segments or chapters. When Multiplex Audio/Video is set to No, DoStudio Authoring will 
reuse the multiplexed files from the last compile and only rewrite the necessary navigation code (BD-J). A 
good rule of thumb is that if you have made edits to your segments or chapters, you will need to do a full 
compile. If you have only made changes to the Menu Elements window, added or changed actions, or 
edited remote control navigation, you can do a Quick Compile. This feature can save you many hours over 
the course of authoring your Blu-ray Disc.
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Compile error messages

During the compile process, DoStudio Authoring checks for any errors in your disc that will prevent it from 
functioning properly. Any issues are reported in the compile window and the compile process is canceled.

Incomplete Disc Settings

You must enter an Organization ID and an Application ID in your Disc Information settings in order to 
successfully compile your Blu-ray Disc. The compiler will notify you if these are missing.

Missing First Play Image

Your project must contain a First Play image. The compiler will notify you if it is missing.

Incomplete Properties for Actions

The compiler will notify you if you have authored a menu action but have not setup the properties for the 
action properly. Normally, this will occur if you have setup an action and then edited or deleted the target 
of the action. The compiler will tell you which menu element or playlist item contains the faulty action.

The Playlist Is Invalid

This message will occur occasionally when you are opening a project created in a 1.x version of DoStudio 
Authoring. Save the project, close DoStudio Authoring, and then reopen your project.

Multiplexing the Assets Has Failed

This message indicates an error in your video and audio streams. If your video and audio streams contain 
an error or are in some way not compliant with the Blu-ray Disc specification, the muxer will return this 
error.  When this occurs, you must determine which of your streams has the error. The compiler does not 
pinpoint which file is problematic at this point.

This message can also occur when you do not have enough free space on your hard drive to compile your 
disc image.

Failed to Create Interactive Layer

This message indicates an authoring error in your project. The most common cause of this error message is 
faulty setup of a condition or APRM. An empty conditional property or an APRM with no value will cause 
this error. It can also occur due to a faulty subtitle file. When this occurs, it is best to check for incomplete 
authoring properties. If you can not determine the problem, please send the DoStudio Authoring log file to 
DoStudioSupport@am.sony.com for review.
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Verifying your compiled disc image
To view your compiled disc image, open your BDMV folder using ArcSoft TotalMedia Theatre.

Alternatively, you can open the Disc folder that is created when you compile and drag the BDMV folder to 
the TotalMedia Theatre icon on your desktop.

Burning a Blu-ray Disc
When you have successfully compiled your project, you can burn a BD-R/RE by clicking the Burn button in 
the compile window. You must select your BD-R drive from the combo box.

This will open ImgBurn if you have it installed on your workstation. You have the option to select whether 
you want to verify the disc after it is burned.

By default, DoStudio Authoring will open the burner application with UDF 2.5 selected, which is the required 
format for Blu-ray Disc burning.

If you do not use the Burn feature built into the compile window, you can always open the Blu-ray Disc 
burner separately and add your files. For more information, see "Using ImgBurn" on page 159.

Formatting your Blu-ray Disc for replication
The final step in the Blu-ray Disc authoring process prior to replication is formatting. This section describes 
how to format your final Blu-ray Disc image.

You should only proceed with formatting when you have performed a full quality-assurance test on your 
project by burning your compiled disc to BD-R/RE and testing the playback in a set-top player. You will not 
be able to play your formatted BD image until you receive your check discs from the replicator.

BDCMF and Managed Copy setup

Prior to formatting your final disc image, you must define the BDCMF settings in the BDCMF tab of the 
Disc Information settings. For more information, see "BDCMF tab" on page 34.

Formatting operations

To format your Blu-ray Disc, choose Compile > Format Blu-ray Disc, click the Format Blu-ray Disc button 
on the toolbar, or press Shift+F5.

If your disc size exceeds 25 GB, DoStudio Authoring will automatically format it as a BD50 disc image. You 
do not need to set the layer break. DoStudio Authoring sets the layer break automatically during the 
formatting process.
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It is important to keep in mind that you will need twice as much space on your workstation's hard 
drive as the size of your compiled project. During the format process, DoStudio Authoring recompiles 
your project, then writes the BDCMF file set. So if your compiled project is 45 GB in size, then you need 
90 GB of disc space on your hard drive to format it successfully.

You will be prompted with a notice warning you that formatting will recompile and format your disc while 
applying AACS information. You will not be able to play your disc in a software player or burn your disc to 
BD-R/-RE once you have formatted the disc image.

If you need to recompile your project after you have created a formatted image, you should delete the 
folder called projectname.BD in your project's root folder prior to compiling. This will delete the formatted 
image so that you can perform a clean compile.

DoStudio Authoring automatically recompiles your project with BD-R/-RE test mode turned off prior to 
formatting. This is a safety precaution because if you accidentally format your disc using a compile that 
was performed in Test Mode, your replicated disc will not play. The recompile also adds the necessary AACS 
preparation to your disc.

After recompiling, the formatting process begins. The formatting process takes about as long as the 
compiling process. It is important to take this into consideration when planning for your deadlines.

The Format window will notify you when your Blu-ray Disc has formatted successfully. It will also notify 
you if there were errors during the formatting process.

DoStudio Authoring writes the BDCMF 1.02 (or BDCMF 1.20 for BD3D) formatted image into the folder you 
selected in the Control Panel. The folder now contains the following files:
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Delivering your disc image to the replication facility

As of this writing, all Blu-ray Disc replicators require that the formatted disc image be delivered on a 
portable hard drive. You cannot deliver your disc image on BD-R/RE. It is best to check with your replicator 
about their preferred format prior to delivering your disc image.

You will send the following files to the replicator:

 n BDCMF.CMF

 n FAI.DAT

 n PACL0.DAT

 n PIC.DAT

 n UCD.DAT

 n UD.DAT
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Audio/video segments
By default, your Blu-ray Disc™ project contains one 2D segment.

Adding, deleting, and editing segments

Adding segments

To add additional segments, right-click the segments in the Playlist tree to display a shortcut menu and 
click the type of segment you want to add. 

You will see the option to add a 3D segment only if you have purchased the DoStudio 3D Authoring 
module.

Deleting segments

To delete a segment, right-click the segment in the tree and choose Remove Segment from the shortcut 
menu.

The order of the segments in the tree does not determine the order they will play.

Editing 2D segment properties

When you select a 2D segment in the Playlist tree, its properties are displayed in the Control Panel.  You can 
rename the segment by typing a new name in the Name box.

You assign the frame rate of the video in your segment using the Frames Per Second drop-down list.  The 
available frame rates are 23.98, 24, 25, 29.97, 50, and 59.94.  Each segment in a Blu-ray Disc project can 
have a different frame rate.

Chapter 6
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Adding primary audio/video streams to segments
The type of video you can add to a segment depends upon whether it is a 2D or a 3D segment. Adding 
audio and subtitle assets is the same for 2D and 3D.

2D segments can also have secondary video streams, which are used for picture-in-picture. 3D segments do 
not support secondary video streams. For information about setting up a secondary video stream, please 
see "Adding secondary audio/video streams (PiP)" on page 73.

Adding 2D primary video

A segment must have a video file assigned to it. When you create a 2D segment, an empty video element is 
created in the tree.

 1. Expand the Primary Audio/Video element in the Playlist tree.

 2. Select the Video element in the Playlist tree.

 3. Click the Browse button in the Control Panel.

 4. Select a video file and click Open.

Supported video codecs

 n MPEG-2 HD (.m2v, .m2p, .mpg, .mpeg)

 n SMPTE VC-1 (.vc1)

 n MPEG-4 AVC  (.avc, .264, .h264)

Adding a primary audio track

 1. To add an audio track to a title, right click the Primary Audio/Video element in the Playlist tree and 
choose Add Audio. 

 2. Choose the file for the track in the Add an Audio File dialog box. 

To update or change a file after it has been added, click the Audio Track element in the tree and select an 
audio file for the track in the Control Panel using the Browse button. You can add multiple audio tracks to 
a title.

Supported audio codecs

 n LPCM 2.0, 5.1, 7.1 (.wav)

 n Dolby Digital 2.0, 5.1 (.ac3)

 n Dolby Digital Plus (.ec3)

 n Dolby TrueHD (.ac3 core + .mlp)

 n DTS  (.dts)
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 n DTS-HD High-Resolution (.dtshd)

 n DTS-HD Master Audio (.dtshd)

Adding secondary audio/video streams (PiP)
DoStudio Authoring supports a secondary video track to create a picture-in-picture (PiP) effect. In this 
document, we will sometimes refer to the secondary audio/video tracks as PiP tracks. You can add multiple 
secondary audio tracks to your PiP track. You can not add subtitles to the PiP track.

You can add multiple secondary video tracks to a title and turn their visibility on and off using actions.

Maximum bit rate for secondary video stream

The total video bit rate value of primary video and secondary video streams (including subtitles) must be 
less than or equal to 38 Mbps.

Maximum video bit rate for secondary video streams must be less than or equal to 7.6 Mbps.

When using a secondary video track, we recommend encoding your primary video track at a maximum bit 
rate of 18 Mbps.

We recommend that you encode your secondary video in standard definition at a maximum bit rate of 5 
Mbps. In order to create two secondary video streams and stay within the prescribed buffer, you should use 
standard definition video encoded at 3.7 Mbps.

Secondary video codecs

You can combine codecs for primary and secondary video as follows:

Primary Video Streams
Secondary Video Streams

MPEG-2 MPEG-4 AVC VC-1

MPEG-2 Allowed Allowed Allowed

MPEG-4 AVC Prohibited Allowed Prohibited

VC-1 Prohibited Prohibited Allowed

Allowed combination of primary video formats and secondary video formats

The Blu-ray Disc specification allows HD or SD secondary video streams, but most Blu-ray Disc players 
cannot play back a secondary video stream that contains HD content. Therefore, we recommend that you 
use only SD video in your secondary video streams.

AUDIO/VIDEO SEGMENTS           73   



Primary video streams

Frame size (pixels) Frame rate (Hz) Progressive/Interlace Aspect ratio

1920x1080 29.97 Interlace 16:9

25 Interlace

23.976 Progressive

24 Progressive

1280x720 59.94 Progressive 16:9

50 Progressive

23.976 Progressive

24 Progressive

720x480 29.97 Interlace 4:3 or 16:9

720x576 25 Interlace 4:3 or 16:9

Secondary video streams

Frame size (pixels) Frame rate (Hz) Progressive/Interlace Aspect ratio

720x480 29.97 Interlace 4:3 or 16:9

720x576 25 Interlace 4:3 or 16:9

Adding a secondary video track

 1. Right click the Secondary Audio/Video element in the Playlist tree and choose Add Secondary Video 
from the shortcut menu. 
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 2. Select the Secondary Video element in the Playlist tree and click the Browse button in the Control 
Panel tab to choose a video file.

 3. You can use the Scale drop-down list in the Control Panel tab to set the scale of the secondary video 
stream to None (actual pixel size), Half Size, or Full Screen (scaled to fill the screen regardless of 
actual pixel size of the video stream).

DoStudio Authoring allows you to implement PiP using a single secondary video stream or with 
multiple secondary video streams.

Case 1: A single secondary video stream

In the Control Panel properties for the secondary audio/video, set One Single Stream to Yes. This means 
that you will use just one video stream for your PiP track.

By default, one secondary video segment is created. If your PiP track will stay visible the entire length of the 
secondary video stream, you will only need one segment. If your PiP track will turn on and off throughout 
the duration of the secondary video stream, you will create multiple segments.

Property Description

Name As with all tree elements in DoStudio Authoring, the name of the 
element can be edited.

Video File This is the location of the secondary video file. For a single secondary 
video stream, this file will be the same as the secondary video stream 
and the  box will be unavailable.

Start The start frame is the timecode number that defines when the PiP 
track will begin. For example, if you want the PiP stream to activate 
10 seconds into the secondary video stream, you would type 
00:00:10:00.

Duration This is the duration of the PiP stream defined in timecode. For 
example, if your PiP stream will stay active for 45 seconds you would 
type 00:00:45:00.
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Property Description

Left Position These numbers define the location of the upper-left corner of the PiP 
stream defined in absolute pixels.Top Position

Scale This drop-down list defines the scale of the PiP stream.

 n None: Displays the PiP stream in its actual pixel size.

 n Half Size: Displays the PiP stream at half its actual pixel size.

 n Full Screen: Scales the PiP stream to fill the entire screen 
regardless of the actual pixel size of the secondary video 
stream.

Since you can use HD and SD streams of various sizes for your 
secondary video, the scale feature will appear differently depending 
on the resolution of the video. A 1920x1080 secondary stream will fill 
the screen if the scale is set to None, whereas a 720x480 stream will 
only consume approximately 1/6th of the screen when the scale is set 
to None.

Case 2: Multiple secondary video streams

In the Control Panel properties for the Secondary Audio/Video, set One Single Stream to No.  This means 
that you will use more than one video stream for your PiP track.

In this scenario, you do not add a video file to the secondary audio/video element in the playlist. Instead, 
you add the video files to the segments that you create.

Property Description

Name As with all tree elements in DoStudio Authoring, the name of the 
element can be edited.

Video File This is the location of the secondary video file. Each segment will 
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Property Description

contain a separate video file.

Start The start frame is the timecode number that defines when the PiP 
track will begin. The start frame is a timecode number for the title, 
not the secondary video. For example, if you want the PiP stream to 
activate 30 seconds into the title, you would type 00:00:30:00.

Duration This is the duration of the PiP stream defined in timecode. For 
example, if your PiP stream will stay active for 45 seconds you would 
type 00:00:45:00.

Left Position These numbers define the location of the upper-left corner of the PiP 
stream defined in absolute pixels.

 
Top Position

Scale This drop-down list defines the scale of the PiP stream.

 n None: Displays the PiP stream in its actual pixel size.

 n Half Size: Displays the PiP stream at half its actual pixel size.

 n Full Screen: Scales the PiP stream to fill the entire screen 
regardless of the actual pixel size of the secondary video 
stream.

Since you can use HD and SD streams of various sizes for your 
secondary video, the scale feature will appear differently depending 
on the resolution of the video. A 1920x1080 secondary stream will fill 
the screen if the scale is set to None, whereas a 720x480 stream will 
only consume approximately 1/6th of the screen when the scale is set 
to None.

Secondary audio codecs

Blu-ray Disc supports Dolby Digital Plus and DTS-HD LBR audio streams for use in the secondary audio 
track.

Attention DVD authors: Standard Dolby Digital files (such as the kind you would create for a DVD) are 
not valid for use as a secondary audio track. You will not be able to compile your project successfully 
if you use a Dolby Digital file in your secondary audio track.

Dolby Digital Plus audio streams for secondary audio

The bit rate of the Dolby Digital Plus audio stream for secondary audio mixing application is variable and 
cannot exceed 256*103 bits/second (256 Kbps).

If the primary audio stream contains more than 5.1 channels, a secondary audio stream with an audio 
coding mode of 1/0 may only be panned to and mixed with the Left, Center, Right, Left Surround and Right 
Surround channels of the primary audio stream.
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DTS-HD LBR audio streams for secondary audio

The bit rate of the DTS-HD LBR audio stream cannot exceed 256*103 bits/second (256 Kbps).

Duration of Synchronized Frame: 32/375 seconds (~85.33 ms))

Sampling Frequency: 48 kHz

Audio Channel Arrangement: 1/0,2/0,3/0,3/1,2/1,2/2,3/2

Notes:

 n DTS-HD(LBR) decoder operates on the subframe block, which is 256 samples. As a result, minimum 
output buffer size is 256 samples for any frame size.

 n When panning the DTS-HD LBR secondary audio stream, audio channel arrangement shall be 1/0.

 n A DTS-HD LBR secondary audio stream shall have two-channel downmixing component in case of 
Audio Channel Arrangement is: 3/0,3/1,2/1,2/2 or 3/2.

Adding a secondary audio track

 1. Right-click the Secondary Audio/Video element in the Playlist tree and choose Add Secondary 
Audio from the shortcut menu. 

 2. Select the Secondary Audio element in the Playlist tree and click the  Browse button in the Control 
Panel tab to choose an audio file.

Unlike the primary audio/video track, you can create a stand-alone secondary audio track that does not 
have an associated secondary video track.

The process of adding segments is similar to the process for adding secondary video. There are two 
exceptions:

 n The secondary audio does not have a left and top position setting.

 n The Secondary Video drop-down list allows you to associate the secondary audio track with an 
existing secondary video track. When the tracks are associated, they become an interleaved sync 
track when you compile your project. An audio track that is associated with a video track will mute 
and unmute when the video track is turned on and off.

Secondary audio/video actions

You control the visibility of the secondary audio and video using actions. For more information, see 
"Secondary audio/video actions" on page 120.
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Adding Dolby TrueHD to your project
Dolby TrueHD consists of a core 5.1 Dolby Digital file (.ac3) plus a lossless 7.1 TrueHD file (.mlp).  

 1. Select the Audio Track element in the Playlist window.

 2. In the Control Panel, click the Browse button to add the core .ac3 file to the first Audio file box.

 3. Click the Browse button to add the core .ac3 file to the Dolby TrueHD Audio file box.

Adding multichannel LPCM files to your project
DoStudio supports multichannel LPCM (.wav) files in 6-channel (5.1 surround) and 8-channel (7.1 
surround) configurations.

6-channel (5.1 surround) channel assignment:

Channel 1 Left

Channel 2 Right

Channel 3 Center

Channel 4 Left Surround

Channel 5 Right Surround

Channel 6 LFE

8-channel configuration (7.1 surround) channel assignment:

Channel 1 Left

Channel 2 Right

Channel 3 Center

Channel 4 Left Surround

Channel 5 Rear-Left Surround

Channel 6 Rear-Right Surround

Channel 7 Right Surround

Channel 8 LFE
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Using a single interleaved .wav file

The channels can be interleaved in a single .wav file by your audio-editing package.  If you have a single, 
interleaved file, then add the multichannel .wav file to your primary audio the same way you would add a 
stereo .wav file or any other single-file audio source: right-click the Primary Audio/Video element and 
choosing Add Audio.

Using individual .wav files

You can also add multichannel LPCM audio by adding individual .wav files. 

 1. Right-click the Primary Audio/Video element in your playlist and choose Add Multichannel Audio. A 
new audio track will be added to your playlist.

 2. Select the new audio track in the Playlist tree and add the individual .wav files in the Control Panel.

For a 5.1-surround multichannel mix, select files for the first 6 channels according to the channel 
assignment described above. Leave Channel 7 and Channel 8 blank.

For a 7.1 multichannel mix, select files for all 8 channels according to the channel assignment described 
above.
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Language display setting

You can assign a language display setting to the audio track using the Language drop-down list.  This 
language setting will be displayed on screen or on the Blu-ray Disc player's front panel display if the player 
supports this display option.

Subtitles

DoStudio Authoring uses graphics-based subtitles for Blu-ray Disc projects.

For more information about creating subtitles, see "Subtitles" on page 59.

Adding slideshow segments
You can use still images instead of motion video in your Blu-ray Disc project by adding a slideshow 
segment. 

Adding or deleting slideshow segments

To add a slideshow segment, right-click Audio Video Segments in the Playlist tree and choose Add 
Slideshow Segment from the shortcut menu.

To delete a slideshow segment, right-click the slideshow segment in the Playlist tree and choose Remove 
Segment from the shortcut menu.
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Slideshow segment properties

When you select a slideshow segment in the Playlist window, its properties are displayed in the Control 
Panel. You can rename the slideshow title by typing a new name in the Name box.

Use the Resolution drop-down list to select the size of the still image(s) you are using in the slideshow 
segment. The options are:

 n HD 1080i 1920x1080

 n HD 720p 1280x720

 n SD 16x9 720x480 anamorphic (image will stretch to fill the screen)

 n SD 4:3 720x480 (4:3 image will be displayed with black bars on the right and left sides

Adding still images to a slideshow segment

 1. Right-click the Primary Slides node in the Playlist tree and choose Add Slides from the shortcut 
menu. The Add Slides dialog is displayed.

 2. Type a value in the Default Length in Seconds box to set the default length for slides. You can edit 
the duration of individual slides after you add them to the slideshow segment.

 3. To add slides to the slideshow segment, click the Add Slides button and select one or more JPG 
images.
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The Add Slides dialog will display your slides in a list after you import them. This is the order they will 
appear when playing your Blu-ray Disc. You can reorder slides by dragging rows in the Add Slides 
dialog. To remove a slide, right-click it and choose Remove.

 4. Click OK to close the Add Slides dialog. When the Add Slides dialog is closed, the slide order is 
locked, so be sure you have them in the order you desire.

You will now see your slides listed in the Playlist tree. When you select a slide, its source file name 
and duration are displayed in the Control Panel.

Type a new value in the Duration box to edit its duration.

Click the Browse button to replace the image used for a slide by selecting a new slide.

You can delete a slide from the tree by right-clicking it and choosing Remove Slide.

Adding audio and subtitles to slideshow segments

You can add audio and subtitle tracks to slideshow segments just as you would add them to primary video.  
To do this, right-click the Primary Slides node in the Playlist tree and choose a command from the shortcut 
menu. The process for adding audio and subtitles and adjusting their properties is the same as it is when 
adding them to primary video.

Playback of slideshow segments

Your slideshow segment will display each slide you have added for its duration then display the next slide in 
the list. If you have added audio and/or subtitles, you will be able to display them just as you would if they 
were attached to primary video. You cannot add chapter points to individual slides in a slideshow segment, 
so the viewer does not have the ability to skip forward or backward while viewing the slides.
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Importing menu graphics in Mosaic
This feature is not available for DSA EX Edition projects. For more information, see "Creating projects" 
on page 29.

This section discusses how to create import menu graphics from a layered Adobe Photoshop (.psd) file 
using an application that comes with DoStudio Authoring called Mosaic. Mosaic is a powerful and flexible 
application that imports a layered .psd file and generates discrete DoStudio Authoring menu elements out 
of each layer in the .psd file according to a simple naming convention. Mosaic allows you to reimport a 
.psd file an unlimited number of times during the authoring process if your menu design undergoes design 
changes. You can choose to preserve your current authoring for any reimported menu element, or you can 
overwrite the authoring with the initial values contained in the .psd file.

Mosaic relies on a naming convention that you must use when labeling the layers of your .psd file before 
importing the file. The naming convention relates to the basic menu elements in DoStudio Authoring: 
blocks, sets, and buttons.

Mosaic can automatically handle the resizing of menu elements from one import to the next and it includes 
a powerful mapping feature that allows you to move the authoring from one menu element to another 
even when you have fundamentally changed the names of menu elements or changed the hierarchical 
structure of your menu system.

Additionally, you can add DoStudio Authoring actions directly to menu elements in your .psd file by adding 
layers to your file with a special kind of shorthand notation in the layer name called Mosaic Action Script.

Chapter 7
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Naming convention for .psd file layers
In order for Mosaic to successfully assign each layer of a .psd file to its proper role in DoStudio Authoring 
you must name each layer according to the naming convention described below for menu blocks, sets, and 
buttons.

Menu blocks

To define a menu block in a .psd file, create a layer and name it with the prefix mb:.

Example: mb: Main Menu

If you want to create a menu block with a transparent background, create an empty layer and name it 
according to the naming convention.  If you create a transparent background, Mosaic will determine the 
size of the menu block from the size of the set.

Sets

Sets are created by using the group feature in Photoshop.  Create a group and name it "Set 1," "Set 2," and so 
on, or name your sets more descriptively such as "Chapters1-5."  There are no special characters to enter in 
the layer name for the set.

You will place your button graphics and set background image (optional) inside the Photoshop group.

Sets will import with a transparent background unless you specify an image for the set's background.  The 
naming convention for a set background is bg:.

Example: bg: nameofsetbackground
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Buttons

Buttons are placed in the Photoshop set and are named according to which button state they represent:

Normal: n:

Example: n: Chapter 1

Selected: s:

Example: s: Chapter 1

Activated: a:

Example: a: Chapter 1
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Important considerations for creating your .psd file:

 n Text layers must be rasterized.

 n Mosaic does not recognize layer effects, so you must fully merge all layer effects into the layer.

 n Your buttons must be contained within the boundaries of your menu block.

 n You can see the actual size of the layer (including the transparent pixels) by selecting the Show 
Transform Controls feature in Photoshop. When this is turned on, you will see a rectangle around 
the actual pixels in the layer. Mosaic reads this layer information and uses it to determine the size of 
your menu block.

 n Your buttons can not overlap.

 n Beware of Glow effects; they can cause overlap problems.

Adding a  .psd file to Mosaic
To begin the import process, start Mosaic by choosing Edit > Import PSD Graphic clicking the Import PSD 
Graphic button in the toolbar.

Mosaic is a separate application that performs the import process and transfers the menu data to DoStudio 
Authoring. Mosaic must complete the import process or you must exit the Mosaic application in order to 
continue authoring in DoStudio Authoring.

To add a .psd file to Mosaic, choose Edit > Add PSD. This opens a browse window that lets you choose your 
.psd file. When you select the file, Mosaic reads each of the layers and generates a log in the Import Status 
tab. If your .psd file has errors that will prevent it from properly importing into DoStudio Authoring, you will 
be notified at this stage.
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Some of the common errors that will be detected include:

 n Menu elements that extend beyond the edge of the HD frame (1920 x 1080)

 n PSDs that are not the correct bit depth (32-bit = 8 bits per channel)

 n PSDs that contain overlapping buttons in the same Menu Set

Working with the Mosaic interface
The Mosaic interface contains the Import Tree, the Control Panel, and four tabs in the preview pane: 
Layout Preview, Import Status, Mapping, and Layer Image.

The Import Tree

The Import Tree displays a tree view of the menu elements that Mosaic reads from your .psd file. Notice 
that the tree view of the Import Tree is similar to the tree view of the Menu Elements window in DoStudio 
Authoring. The tree displays the menu blocks, sets, and buttons just as you would see them when they are 
imported into DoStudio Authoring. It displays some additional information as well.

Under each menu block in the Import Tree, you will see an icon corresponding to the .psd file layer that 
defines the menu block.

You can expand the tree view for each button in your menus to display an icon for each of the button state 
images. You can further expand each of the button state icons in the Import Tree to see an icon that 
corresponds to the .psd file layer that defines the image for the button state.
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Selecting any item in the Import Tree displays the item's properties in the Control Panel. The next section 
examines each item's Control Panel properties. But let's look at a few more functions in the Import Tree 
before we get into the Control Panel properties.

Estimated Image Buffer Size

The Import Tree calculates the size of your menu graphics in bytes and displays this value at the top of the 
Import Tree. This relates to how much of your image buffer is used by your menu system. For more 
information about calculating the image buffer size, see "The image buffer" on page 13.

Selecting the location of your images folder

The Image Folder box allows you to specify the name of the folder you would like Mosaic to use to store 
your menu graphics. This folder will always be created inside your project's .content folder contained within 
the root directory that houses your project file. Simply type a new name in the box. If the folder name you 
specify does not exist, it will be created when you import your .psd file into DoStudio Authoring.

Choosing which menu elements to import

You can choose which elements to import by using the  check boxes. By default, all elements are selected for 
import. You may, for example, clear the check boxes for entire menu blocks or sets or individual buttons to 
only import the elements you need. This is useful if you have made a change to just one part of your .psd 
file and you want to reimport only the element that has changed. In this case, clearing the check box next 
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to a menu element in the Import Tree will preserve the previously imported graphics and authoring (actions 
and remote control settings) for that menu element in your DoStudio Authoring project.

You can also select whether or not to import an element using the Import Layer check box found in the 
Control Panel when you have selected the menu element. When you make an import/don't import selection 
in the Import Tree, it will be reflected in the Control Panel and vice versa.

You can make a global "import all" selection by clicking the Use Current Actions button at the bottom of 
the Import Tree. This will select all of the check boxes. Likewise, you can make a global "import none" 
selection by clicking the Use DSA Actions button at the bottom of the Import Tree. This will clear all of the 
check boxes.

Expanding/collapsing the Import Tree view

Use the arrows next to a menu element's icon to expand or collapse the tree layers under it. You can use the 

Expand  and Collapse  buttons at the bottom-left corner of the Import Tree to expand or collapse 
the entire tree.

Control Panel properties

You can select any of the blocks, sets, or buttons to view and edit their properties in the Control Panel. Let's 
look at the available properties in detail.

Menu blocks

When you select a menu block in the Import Tree, the Control Panel displays the name of the menu block, 
the image buffer size, and the size and position properties for the menu block. The Top and Left positions 
are measured in pixels from the top left of the screen. The Width and Height boxes describe the size of the 
menu block.

The Current values are for the .psd file you currently have loaded into Mosaic. If you are reimporting a ,psd 
file, you will see Previous values as well. The Previous values describe the size of the menu block that is 
currently in your DoStudio Authoring project. If you haven't changed the size of the menu block, the values 
will be the same.

You can edit the size and position values of your menu elements at this stage if you desire; however, you 
will not need to edit these values if you have laid out your menus in Photoshop to your liking. For example, 
if your .psd file is 1920 x 1080 at 72 dpi, the position of all of the menu elements in Mosaic is exactly the 
same as you designed them in Photoshop.
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Sets

Selecting a set in the Import Tree displays the same position and size values as when you selected a menu 
block. Likewise, you will see both Previous and Current values if you are reimporting a .psd file.

Buttons

When you select a button in the Import Tree, you see three tabs in the Control Panel: Properties, Actions, 
and Remote Control Navigation.

The Properties tab describes the position and size values for the button. If you are reimporting a file, you 
will see both Previous and Current values.

In the Actions tab, you see any actions that have been imported with the button using Mosaic Action Script. 
You can select the Enter, Up, Down, Left, and Right events to see where actions have been assigned. If you 
are reimporting a file with Mosaic Action Scripts, you can choose to preserve the actions you have authored 
in DoStudio Authoring for that button by selecting the Use Previous option, or you can overwrite the 
authoring you have performed in DoStudio Authoring by selecting the Use Current option.  Selecting Use 
Current will replace any actions you have authored in DoStudio Authoring with the actions that are 
included in the .psd file with Mosaic Action Script.

In the Remote Control Navigation tab, you see any remote control navigation that has been imported with 
the button using Mosaic Action Script. As with the Actions tab, you can choose to preserve the remote 
control navigation you have authored in DoStudio Authoring by selecting the Use Previous option or you 
can overwrite the remote control navigation authoring by selecting the Use Current option.  Selecting Use 
Current will replace any remote control navigation you have authored in DoStudio Authoring with the 
remote control navigation that is included in the .psd file with Mosaic Action Script.
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Import Status tab

The Import Status tab contains a log that is generated when you initially select your .psd file for import. It 
lists all of the menu layers that are imported and flags any errors or warnings due to problems with the file.

Layout Preview tab

The Layout Preview tab displays the menu layout as it will appear in DoStudio Authoring. You can select the 
visibility of each menu element  by selecting the check box next to the element's name in the Import Tree. 
You can view the buttons in their three button states (normal, selected, and activated) by using the Display 
Button State list.
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Layer Image tab

The Layer Image tab displays the image associated with the item that is currently selected in the Import 
Tree.

Mapping tab

The Mapping tab allows you to remap the properties from one menu element to another menu element 
when you reimport a Photoshop file in which menu elements have been substantially rearranged. Mapping 
allows you to preserve the authoring (actions and remote control navigation) that is currently assigned to 
one menu element and map it to another one. This prevents you from ever having to simply start over 
because you have made too many changes to your menu design.

If you are importing a .psd file into a new DoStudio Authoring project, the Mapping tab will only show one 
column. The Mapping tab is designed to be used only when you are reimporting a .psd file.

By default, the Mapping tab displays two columns: the Current Import and the Previous Menu. The Current 
Import column displays the layers that are currently being imported from your .psd file by Mosaic. The 
Previous Menu column displays the current menu structure in your DoStudio Authoring project. You can 
expand the trees using the triangle icons in the same way that you expand the Import Tree. You can view 
the menu blocks, sets, buttons. and button state images (normal, selected, and activated) in the trees.
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When you reimport a .psd file, Mosaic attempts to map the existing menu elements to the current import by 
matching the menu element names. Mapping means that Mosaic will transfer the actions and navigation 
to the previous project.

When Mosaic is able to map a menu element from the previous menu to the current import, the layer 
displays a green button next to it. Selecting a mapped menu element in the previous menu tree displays a 
line connecting it to the mapped element in the current import. Menu blocks will map to menu blocks, sets 
will map to sets, blocks will map to blocks, and button states will map to button states.

If Mosaic is not able to successfully map a menu element from the previous menu to the current import, 
then the unmapped element displays a red button next to it. This can happen when you move a button 
from one menu or set to a different one, or if you add or delete menu elements from one version of the .psd 
file to the next.

Remapping menu elements using drag-and-drop actions

The Mapping tab allows you to manually re-map a menu element by dragging a menu element from one 
tree to the other. When you re-map a menu element a new connector line will be drawn between the 
elements and they will both display green buttons.
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Displaying the Photoshop layers

The Mapping tab also allows you to view the Photoshop file in layers. Click the arrow button in the upper 
left corner of the Mapping tab to display the layers.

You will see that the .psd file layers are mapped to the Current Import and display green buttons where a 
successful map has been achieved. You can change the mapping of the Photoshop layer to the Current 
Import by dragging a Photoshop layer to a menu element in the Current Import tree. This will redraw the 
connecting line and change which Photoshop layer  is used for the menu element.

Importing menu elements into DoStudio Authoring
When you are ready to add or update the menu graphics in your DoStudio Authoring project, choose File > 
Import Into DoStudio to complete the import process. The menu elements will now appear in the DoStudio 
Authoring project.

If you imported a full resolution 1920 x 1080 image then your layout work is done. You will need to assign 
navigation and playback actions to the buttons you have just imported.

If your .psd file contains only one portion of your menu and the pixel size of the file is smaller than 1920 x 
1080, the element will appear in the top-left corner of the Layout Editor window when you import it into 
DoStudio Authoring. You can then position the menu block on your own.

Reimporting a Photoshop file
If you make changes to your graphics while you are in the middle of authoring your Blu-ray Disc, you can 
reimport your Photoshop file using Mosaic. Simply open Mosaic by clicking the Import a Photoshop file 
button and open your updated .psd file. Select which elements you want to reimport by selecting them with 
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the check boxes and choosing whether you want to preserve the authoring from your DoStudio Authoring 
project for those menu elements (Use Previous) or overwrite any authoring for those menu elements with 
the values in your .psd file (Use Current). When you import the file into DoStudio Authoring, it will update 
the graphics in your project.

Mosaic Action Script
Mosaic includes the ability to read a powerful shorthand notation called Mosaic Action Script that allows 
you to add actions and remote control navigation to your menu element inside your Photoshop file. Mosaic 
Action Script is a great time-saving tool that lets you turn .psd files into DoStudio Authoring templates; 
however, it is intended for use by experienced authors.

Mosaic Action Scripts are contained in the .psd file layer names. In Mosaic 2.0, you can create special 
layers without any graphics that just contain Mosaic Action Scripts in the layer name without any graphics 
in the layer. This makes it easy to reuse the action script layers from one file to the next – you simply copy 
the layers into a new .psd file.

Adding Mosaic Action Script to buttons

To add an action script to a button, create a group in your .psd file with the prefix as: and the name of the 
button you would like to add the action script to. For example, as: MM Play Film. This will add action scripts 
to the button called MM Play Film.

Next, add layers inside the group that include the action script shorthand. You can specify whether to add 
the action to the Enter, Up, Down, Left, or Right event for the button by using the following prefixes:

 n enter:

 n up:

 n down:

 n left:

 n right:

If you want to add more than one action to a button event, separate the actions with the pipe symbol (|). 
Separate action parameters with the tilde symbol (~).

For example, let's add two actions to the Enter event for the button called MM Play Film.  We'll add a Clear 
Menu Blocks from Screen action and a Play Chapter action that plays Playlist 1, Segment 1, Chapter 2. To 
do this our layer would look like this: enter: CA | PLC=PL:Playlist 1~2D:Segment 1~CH:Chapter 2.
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Adding remote control navigation to menu sets

To add remote control navigation to a menu set with action script, create a group in your .psd file with the 
prefix ng: and the name of the set to which you would like to add the action script. Then add the pipe 
symbol (|) and either horizontal or vertical to add horizontal or vertical navigation. For example, ng: 
Chapters Set | horizontal.

You do not need to add any layers inside the group.

You can nest your Mosaic Action Script groups inside of one group to keep your layers organized and 
manageable.

Menu block animation actions

For more information about these actions, see "Menu block animation actions" on page 105.

Action Abbreviation Parameters

Animate This Menu Block From The Top ANMBT Menu Block Name

Animate This Menu Block From The Bottom ANMBB Menu Block Name

Animate This Menu Block From The Left ANMBL Menu Block Name

Animate This Menu Block From The Right ANMBR Menu Block Name
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Button association actions

For more information about these actions, see "Button association actions" on page 105.

Action Abbreviation Parameters

Associate This Button To Audio 
Track

ASBTAT PL:Playlist Name~AT:Audio Track Name

Associate This Button To Chapter ASBTCH PL:Playlist Name~2D:2D Segment Name~CH:Chapter 
Name

PL:Playlist Name~3D:3D Segment Name~CH:Chapter 
Name

PL:Playlist Name~SL:Slideshow Segment 
Name~CH:Chapter Name

Associate This Button To A 
Subtitle Track

ASBTST PL:Playlist Name~ST:Subtitle Name

Associate This Button To Subtitles 
Off

ASBTSTO PL:Playlist Name

Display menu actions

For more information about these actions, see "Display menu actions" on page 108.

Action Abbreviation Parameters

Clear Menu Blocks from Screen CA  

Hide The Active Menu Block HMM  

Hide Menu Block HMB Menu Block Name~Button Name

Load new Set in Menu Block LS Menu Block Name~Set Name~Button Name

Reset Current Active Menu Block RCMB  

Show Menu Block SMB Menu Block Name~Set Name~Button Name

Show Menu Block Without A Focus Button SMB Menu Block Name~Set Name

Switch Active Menu Block SWMB Menu Block Name~Set Name~Button Name

Toggle Menu Blocks TOM  
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Display button actions

For more information about these actions, see "Display button actions" on page 112.

Action Abbreviation Parameters

Deactivate Button    

Change Button Image to Activated CIA Button Name

Change Button Image to Normal CIN Button Name

Change Button Image to Selected CIS Button Name

Set Button As Activated SBA Button Name

Set Button As Selected SBS Button Name

Title playback actions

For more information about these actions, see "Title playback actions" on page 114.

Action Abbreviation Parameters

Fast Forward FF  

Next Chapter NC  

Pause PA  

Play PL  

Play Chapter PLC    PL:Playlist Name~2D:Segment Name~CH:Chapter Name

PL:Playlist Name~3D:Segment Name~CH:Chapter Name

Example: PLC=PL:001~2D:001~CH:001

Play PlayList PLPL PL:Playlist Name

Example: PLPL =PL:001

Jump To Point TTM Time in Seconds

Toggle Play/Pause TOGPLPA  

Previous Chapter PC  

Resume to Time in Playlist RS  

Rewind RW  

Set Resume Point For PlayList SSRP  

Stop ST  
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Subtitle actions

For more information about these actions, see "Subtitle actions" on page 117.

Action Abbreviation Parameters

Set Subtitle Track SST PL:Playlist Name~2D:Segment Name~ST:Subtitle Name

PL:Playlist Name~3D:Segment Name~ST:Subtitle Name

Turn Subtitles On ONST  

Turn Subtitles Off OFFST  

Toggle Subtitles TOGST  

Primary audio/video actions

For more information about these actions, see "Primary audio/video actions" on page 119.

Action Abbreviation Parameters

Set Main Audio Level SL Audio Level Percentage (1-100)

Set Audio Track SAT PL:Playlist Name~2D:Segment Name~AT:Audio Track Name

PL:Playlist Name~3D:Segment Name~AT:Audio Track Name

Mute Menu Main Audio MTMA  

UnMute Main Audio UTMA  

Secondary audio/video actions

For more information about these actions, see "Secondary audio/video actions" on page 120.

Action Abbreviation Parameters

Set Secondary Video SSVT PL:Playlist Name~2D:Segment Name~SVT:Secondary Video 
Track Name

PL:Playlist Name~3D:Segment Name~SVT:Secondary Video 
Track Name

Set Secondary Audio SSAT PL:Playlist Name~2D Segment Name~SAT:Secondary Audio 
Track Name

PL:Playlist Name~3D Segment Name~SAT:Secondary Audio 
Track Name

Set Secondary Audio Level SSAL Audio Level Percentage (1-100)

Turn Secondary 
Audio/Video On

ONSA  

Turn Secondary 
Audio/Video Off

OFFSA  

Mute Secondary Audio MTSA  

UnMute Secondary Audio UTSA  
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Sound effect actions

For more information about these actions, see "Sound effect actions" on page 122.

Action Abbreviation Parameters

Play Sound PLS SE:Sound Effect Name

Mute Sound Effects MTS  

unMute Sound Effects UTS  

System actions

For more information about these actions, see "System actions" on page 124.

Action Abbreviation Parameters

Set Advanced Parameter STAP APRM Name~Value

Set General Purpose Register    

Add To Advanced Parameter ADAP APRM Name~Add Number

Subtract From Advanced Parameter SBAP APRM Name~Subtract Number

Multiply Advanced Parameter MPAP APRM Name~Multiply Number

Divide By Advanced Parameter DVAP APRM Name ~ Divide Number

Random Number for Advanced 
Parameter

RNAP APRM Name~Seed Number~Maximum 
Number

Round Advanced Parameter RDAP APRM Name

Absolute Advanced Parameter ASAP APRM Name

Move APRM to GPRM    

Move GPRM to APRM    

Move SPRM to APRM    

Animation actions

Action Abbreviation Parameters

Animate Menu Block From The Bottom ANMBB Menu Block Name

Animate Menu Block From The Top ANMBT Menu Block Name

Animate Menu Block From The Left ANMBL Menu Block Name

Animate Menu Block From The Right ANMBR Menu Block Name
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Using actions
By now you have imported your menu graphics from a layered Photoshop file and set up your playlist. Now 
it is time to author the menu interactivity for your Blu-ray Disc™.

Actions are functions that create the interactive functionality of your Blu-ray Disc. The beauty of actions is 
that you can author sophisticated navigation and event-based interactivity in your BD project without ever 
touching a line of code. The actions do all of the work for you.

Assigning and removing actions
Actions are assigned in the Control Panel when you have selected an element that supports actions.

Actions can be assigned to the following elements in your project:

 n Menu Navigation Buttons (Enter, Up, Down, Left, Right)

 n Menu Display events (On Show, On Hide)

 n Menu Button Display events (On Show)

 n Remote Control Buttons (Play, Pause, Pop Up Menu, Rewind, Fast Forward, Red Button, Green 
Button, Blue Button, Yellow Button)

 n Playlist Start

 n Playlist End

 n Chapter Start

Some elements in your project perform certain tasks inherently and do not need actions assigned to 
them unless you are creating some type of specialized interactivity:

 n Pop Up Menu  – The Pop Up Menu element found in the Playlist User Operation will 
automatically toggle the Main Menu on and off screen. You do not need to add the Show/Hide 
Main menu actions for the Pop-Up Menu to work.

 n Play/Pause/Rewind/Fast Forward – These elements found in the Playlist work inherently and 
you do not need to assign an action to cause them to work. For example, you do not need to 
assign the Play Action to the Play button. The Play button performs that function 
automatically. You can add Actions to these Playlist elements to create other kinds of 
interactivity. For example, you may want to cause a Menu to show or hide when the viewer 
presses a remote control button.

 n Playlist End – You do not need to assign a Play Title or Play Chapter Action to the Playlist End 
element. Instead, use the On End Play setting in the Control Panel to determine the order the 
titles should be played in your Playlist.

Chapter 8
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Assigning actions

The process for assigning actions is the same regardless of which element the action is assigned to.

 1. Select an element in the Menu Elements tree.

The Action List in that element is displayed in the Control Panel.This displays the Actions window for 
that element in the Control Panel.

 2. Right-click the Action List to display a shortcut menu of actions grouped by type.

 3. Choose an action from one of the submenu groups.

If the action has editable properties, the properties are displayed in the Control Panel to the right of 
the Action List.

In the example above, the Play Chapter action has been assigned to a button's Enter Key event to 
play Chapter 1 of the Main Video segment in the PlayList - Main Video playlist.

You can assign multiple actions to an event. The actions are executed from top to bottom in the list. 
Drag actions to reorder them.

Removing actions

To remove an action, right-click it in the Action List and choose Remove Action from the shortcut menu.

Copying and pasting actions

You can copy and paste actions directly in the Action List. Right-click an action and choose Copy. To paste 
an action, right-click in an empty part of the Action List and choose Paste.

If you want to copy all of the actions assigned to an element and paste them to another element, 
right-click the element in the Menu Elements tree and choose Copy.  Then right-click the element to 
which you want to paste the actions and choose Paste.  All of the actions will now be assigned to the 
new element.
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Menu block animation actions
You can cause a menu block to animate on and off screen anytime the menu block is shown or hidden by 
adding menu block animation actions to the On Show and On Hide events for the menu block. The menu 
block animation actions are only available when you have selected the  On Show or On Hide event for a 
menu block in the Menu Elements tree.

The menu block animation options are similar to the regular animation actions. The only difference is that 
you do not need to specify a menu block because the menu block animation actions are inherently applied 
to a specific menu block.

For more information about regular animation actions, see "Animation actions" on page 129.

Button association actions
The button association actions are used in conjunction with sticky button groups. In order for these actions 
to work properly, you must assign them to buttons that have been assigned to a sticky button group. The 
button association actions can only be applied to the On Show event for a button. They will not appear as 
an option in the Control Panel unless you have selected a button's On Show event in the tree.

The button association actions are used to create smart selections for audio and subtitle track setup menus 
and chapter selection menus. When used properly, the button association actions will cause buttons to 
highlight when their associated track or chapter is playing.

Associate This Button To Audio Track

The Associate This Button To Audio Track action causes the button to change its display state depending 
on what audio track is playing. If the audio track that is associated with the button is playing when the 
button appears on screen, the button will appear in its activated state. This can be used in a setup menu 
where you want to give the viewer feedback as to which audio track is currently active.

You can apply this action multiple times to the same button so that it can be associated with multiple audio 
tracks in different playlists.
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Property Description

Playlist Name Select the playlist you want to associate with this button.

Audio Track Number Select the audio track you want to associate with this button.

This action can be used with any other action.

Associate This Button To Chapter

The Associate This Button To Chapter action causes the button to change its display state depending on 
what chapter is currently playing. If the chapter that is associated with the button is playing when the 
button appears on screen, the button will appear in its selected state. This can be used in a chapters 
selection menu where you want to give the viewer feedback as to which chapter is currently playing.

You can apply this action multiple times to the same button so that it can be associated with multiple 
chapters in different playlists.

Property Description

Playlist Name Select the playlist you want to associate with this button.

Segment Select the segment you want to associate with this button.

Chapter Select the chapter you want to associate with this button.

This action can be used with any other action.
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Associate This Button To A Subtitle Track

The Associate This Button To A Subtitle Track action causes the button to change its display state 
depending on what subtitle track is currently active. If the subtitle track that is associated with the button is 
active when the button appears on screen, the button will appear in its activated state. This can be used in a 
setup menu where you want to give the viewer feedback as to which subtitle track is currently active.

You can apply this action multiple times to the same button so that it can be associated with multiple 
subtitle tracks in different playlists.

Property Description

Playlist Name Select the playlist you want to associate with this button.

Subtitle Select the subtitle you want to associate with this button.

This action can be used with any other action.

Associate this Button To Subtitles Off

The Associate This Button To Subtitles Off action causes the button to change its display state if the 
subtitles are off. If the subtitles are off when the button appears on screen, the button will appear in its 
activated state. This can be used in a setup menu where you want to give the viewer feedback as to which 
subtitle track is currently active.

You can apply this action multiple times to the same button so that it can be associated with multiple 
subtitle tracks in different playlists.

Property Description

Playlist Name Select the playlist you want to associate with this button.
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This action can be used with any other action.

Display menu actions
The following describes each of the display menu actions in detail. If the action has editable properties, a 
screen shot of the Control Panel is included.

Clear Menu Blocks from Screen

The Clear Menu Blocks from Screen action removes all menu blocks from the screen so that only the video 
remains. This action is often combined with a Play Chapter action so that when the viewer makes a chapter 
selection, all of the menu blocks disappear from the screen to allow the video to play unobstructed.

There are no properties to edit for this action.

Do not use this action with the Show Menu Block or Toggle Menu Blocks actions.

Hide The Active Menu Block

The Hide The Active Menu Block action causes the current active menu block to disappear from the screen. 
If you have assigned animation properties to the menu block's On Hide event, the animation will occur 
when the action is executed.

There are no properties to edit for this action.

Do not use this action with the Show Menu Block action.

Hide Menu Block

The Hide Menu Block action causes a menu block to disappear from the screen.

If you have assigned an animation action to the menu block's On Hide event, the animation will occur 
when this action is executed.

Property Description

Menu Block Name Choose the menu block to hide.

Selected Button Choose the button that will receive focus.
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You do not need to choose the menu block and set that correspond to the button you have selected. In 
most cases, the correct menu block and set will already be visible on screen. If they are not, you can add the 
necessary additional actions to make sure they are on screen. If you set button focus to a button that is not 
visible on screen, your viewer will have a difficult time continuing to navigate your Blu-ray Disc.

Do not use this action with the Hide The Active Menu Block or Clear Menu Blocks from Screen actions.

Load new Set in Menu Block

The Load new Set in Menu Block action changes which set is visible in a menu block. This action can be 
used for any menu block assuming it has more than one set.

Property Description

Menu Block Choose the menu block to load.

Set Name Choose the set to load.

Focus Button Choose the button that will receive focus.

Do not use this action with the Hide Menu Block, Show Menu Block, or Clear Menu Blocks from Screen 
actions.

Reset Current Active Menu Block

The Reset Current Active Menu Block action returns the active menu block designation to the default active  
menu block as defined in your Menu Elements tree. The menu block at the top of the menu tree is the 
default active  menu block.

Do not use this action with the Show Menu Block action.
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Show Menu Block

The Show Menu Block action causes a menu block to appear on screen. If you have added animation 
actions to the On Show event for the menu block, the animation will occur when the Show Menu Block 
action is executed.

Property Description

Menu Block Name Choose the menu block to show.

Set Name Choose the visible set.

Selected Button Choose which button will have focus.

You will notice that the combo box for the Selected Button includes all of the buttons in your project, 
rather than just the button contained in the set you have selected. This is because there are instances when 
you may wish to display a submenu block but keep button focus – and therefore navigation control – on 
another menu block entirely.

A practical example illustrates this feature. Imagine you design a menu for your project's chapters and you 
want to create a thumbnail image that appear in a different part of the screen that corresponds to each 
chapter in the chapter menu. You can create an additional menu for the thumbnail images, and use the 
Show Menu Block action to change the visibility of the sets in that submenu every time a new chapter is 
highlighted. In this case, you would never want to actually navigate to the additional menu; you are only 
using it to display images and you want your navigation, and therefore your button focus, to remain on 
your chapter submenu.

Do not use this action with the Hide Menu Block action.
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Show Menu Block Without A Focus Button

The Show Menu Block Without A Focus Button action causes a menu block to appear on the screen but will 
not change the focus of the currently focused button.

Property Description

Menu Block Name Choose the menu block to show.

Set Name Choose the visible set.

Switch Active Menu Block

The Switch Active Menu Block action allows you to define which menu block is associated with the pop-up 
menu button on the remote control.

Property Description

Menu Block Choose the menu block to show.

Set Name Choose the visible set.

Focus Button Choose which button will have focus.
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Toggle Menu Blocks

The Toggle Menu Blocks action toggles the current active menu block on and off screen. If the current 
Active Menu Block is visible, this action will hide the Menu Block. Likewise, if the Active Menu Block is not 
visible, this action will show the Menu on screen. It uses the last visible set in the menu block.

There are no properties to edit for this action.

Do not use this menu block with the Show Menu Block, Hide The Active Menu Block, or Clear Menu Blocks 
from Screen actions.

Display button actions

Deactivate Button

This will deactivate a button as long as that button doesn't belong to a button group. This is useful if you 
want to programmatically change an activated button.

Property Description

Button Select the button to deactivate.

These actions have specialized uses and are generally combined with advanced authoring techniques such 
as conditions and APRMs in order to check the playback status of the Blu-ray Disc and adjust the menu 
graphics accordingly.

Change Button Image to Activated, Normal, or Selected
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These actions change a button's image without affecting which button has focus. These actions have 
specialized uses and are generally combined with advanced authoring techniques such as conditions and 
APRMs in order to check the playback status of the Blu-ray Disc and adjust the menu graphics accordingly.

These actions must be used carefully as they can cause more than one button to appear to be in the same 
focused state at the same time. They are recommended for advanced authors.

Property Description

Button Select which button you want to apply the action to.

Set Button As Activated

This action activates a button. If the newly activated button is not part of a button group, this action also 
deactivates the previously active button. If the newly activated button is part of a button group, this action 
deactivates the previously active button in the button group.

Property Description

Activated Button Choose which button to set as activated.

Set Button As Selected

The Set Button As Selected action sets the focus for a button without showing or hiding menu blocks. A 
button that receives focus will appear in the selected state. The button that was previously in the selected 
state will return to the normal state when this action is executed.

Property Description

Focus Button Choose which button will receive focus from a list of all buttons in your project.

This action can be used with any other action.
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Title playback actions
Title playback actions directly affect the playback of the Blu-ray Disc.

Fast Forward

The Fast Forward action causes the Blu-ray Disc player to fast forward the currently playing video 
regardless of the user operations.

There are no properties to edit for this action.

Next Chapter

The Next Chapter action causes the Blu-ray Disc player to jump to the next chapter in the title. This has the 
same effect as pressing the Next Chapter button on the remote control.

There are no properties to edit for this action.

Do not use this action with the Previous Chapter action.

Pause

The Pause action causes the Blu-ray Disc player to pause playback. This has the same effect as pressing the 
Pause button on the remote control.

There are no properties to edit for this action.

Do not use this action with the Play action.

Play

The Play action causes the Blu-ray Disc player to resume playback from a paused state. This has the same 
effect as pressing the Play button on the remote control. If the disc is already playing, this action has no 
effect.

There are no properties to edit for this action.

Do not use this action with the Pause or Stop actions.

Play Chapter

This is the most commonly used of the title playback actions. This action causes the Blu-ray Disc player to 
jump from whatever part of the disc it is currently playing and start playing at the playlist and chapter 
specified in the action.

You must define at least one chapter in your playlist in order to use the Play Chapter action.
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Property Description

Playlist Name Select a playlist.

Segment Select a segment.

Chapter Select a chapter.

Do not use this action with the Play PlayList action.

Play PlayList

The Play PlayList action causes the Blu-ray Disc player to jump from whatever part of the disc it is currently 
playing and start playing from the beginning of the playlist specified in the action.

Property Description

PlayList Name Choose the playlist to play when this action is executed.

Do not use this action with the Play Chapter action.

Jump To Point

The Jump To Point action lets you jump playback to a specified point in a playlist defined by the number of 
seconds from the start of the playlist.
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Property Description

Time in Seconds Type the time in seconds from the start of the playlist for the jump point.

Do not use this action with the Resume actions.

Toggle Play/Pause

The Toggle Play/Pause action causes the video to play if it is currently in a paused state and it pauses the 
video if it is currently playing.

There are no properties to edit for this action.

Do not use this action with the Play or Pause actions.

Previous Chapter

The Previous Chapter action causes the Blu-ray Disc player to jump to the previous chapter in the title. This 
has the same effect as pressing the Previous Chapter button on the remote control.

There are no properties to edit for this action.

Do not use this action with the Next Chapter action.

Stop

The Stop action stops playback of the disc. Only use this action in cases when you actually want to stop 
playback of the disc and later cause the disc to resume playback from the beginning.

There are no properties to edit for this action.

Resume to Time in Playlist

The Resume to Time in Playlist action starts playback of a playlist at the previously stored resume point. 
This action should only be applied to the Start event of a playlist.

There are no properties to edit for this action.

This action can be used with any other action.
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Rewind

The Rewind action causes the Blu-ray Disc player to rewind the currently playing video regardless of user 
operations.

There are no properties to edit for this action.

Set Resume Point for PlayList

The Set Resume Point for PlayList action sets a resume point in the playlist at the moment the action is 
executed. Executing the action again overwrites the previous resume point and sets a new one. Only one 
resume point can be stored per playlist.

There are no properties to edit for this action.

This action can be used with any other properties.

Blu-ray only actions
Blu-ray only actions are used to access Blu-ray Disc titles.

Play Blu-ray Title

The Play Blu-ray Title action is used to play a custom Blu-ray Disc title other than the DoStudio BD-J menu 
title.  Playing a Blu-ray Disc title will cause the DoStudio BD-J menu to unload from memory.

You can only add Blu-ray Disc titles if you are using DoStudio EX.

Property Description

BD Title Name Select the Blu-ray Disc title you want to play from the list.

This action should only be used if you understand how to author HDMV navigation commands in 
movie objects otherwise you will never be able to return to the BD-J menu system.

This action can be used with any other action.

Subtitle actions
Subtitle actions are used to set the visibility of subtitle tracks included in your Blu-ray Disc.

Set Subtitle Track

The Set Subtitle Track action is used for Blu-ray Discs that contain more than one subtitle track. When this 
action is executed, the specified subtitle track appears on screen when that title is played.
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Property Description

Playlist Name Select the playlist in which the subtitle track is contained.

Segment Select a segment in the playlist.

Subtitle Enter the number order of the subtitle track.

If your project only has one subtitle track, then the subtitle number is 
1. Each additional subtitle track that you add in your playlist is 
assigned the next highest number.

Although the Set Subtitle Track action requires you to specify a track number in a playlist, when the 
Blu-ray Disc player jumps to the next playlist (if your Blu-ray Disc has more than one playlist) it will 
keep playing the subtitle track that was selected. If you set a subtitle track to play that is in number 
order 2, your disc will continue to play the subtitle tracks in number order 2 in subsequent playlists. If 
the Blu-ray Disc player reaches a title that does not have a subtitle track in that number order, it will 
default back to the first subtitle track. If a subsequent playlist does not have any subtitle tracks, no 
subtitles will be displayed.

This action can be used with any other action.

Turn Subtitles On

This action makes the most recently viewed subtitle track visible on screen. For example, if you had 
previously set your Spanish subtitle track to visible using the Set Subtitle Track action, and then used the 
Turn Subtitles Off action to hide the subtitles, the Turn Subtitles On action would make the Spanish subtitle 
track visible again.

If you have not previously set a subtitle track's visibility using the Set Subtitle Track action, the Turn Subtitles 
On action will make visible the first subtitle track listed in your playlist.

There are no properties to edit for this action.

This action can be used with any other action.

Turn Subtitles Off

This action removes the currently visible subtitle track from the screen.

There are no properties to edit for this action.

This action can be used with any other action.
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Toggle Subtitles

This action toggles the visibility of the most recently selected subtitle track.

There are no properties to edit for this action.

This action can be used with any other action.

Primary audio/video actions
Primary audio/video actions affect the playback of elements that are found in the Primary Audio/Video 
portion of your playlist.

Set Main Audio Level

The Set Main Audio Level action determines the volume of your primary audio track. The volume is defined 
as a percentage that you enter in a text box as seen below.

Property Description

Audio Level Percentage The acceptable range of numbers is 1-100.

This action can be used with any other action.

Set Audio Track

The Set Audio Track action is used to change which primary audio track is playing. By default, when you 
play a playlist, the first audio track listed under Primary Audio/Video in the segment will play.

USING ACTIONS           119   



Property Description

Playlist Name Choose a playlist.

Segment Choose a segment.

Audio Track Number Choose an audio track.

The audio tracks have a number order. The first audio track listed under the segment is number 1, the 
next audio track you add is number 2, and so on. If you set an audio track to play that is in number 
order 2, your disc will continue to play the audio tracks in number order 2 in subsequent titles. If the 
Blu-ray Disc player reaches a title that does not have an audio track in that number order, it will 
default back to the first audio track.

This action can be used with any other action.

Mute Main Audio

This action mutes playback of the primary audio track.

There are no properties to edit for this action.

This action can be used with any other action.

UnMute Main Audio

This action unmutes playback of the primary audio track. The track that was playing when the track was 
muted will be audible again.

There are no properties to edit for this action.

This action can be used with any other action.

Secondary audio/video actions
You can control the visibility of the secondary video using actions. DoStudio Authoring includes the 
following actions related to secondary video:

Set Secondary Video

Use this action to turn on a secondary video track (PiP).
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Property Description

Playlist Name Choose a playlist.

Segment Choose a segment.

Secondary Video Choose a secondary video track.

This action can be used with any other action.

Set Secondary Audio

Use this action to select a secondary audio track. This action must be used with the Turn Secondary 
Video/Audio On action.

Property Description

Playlist Name Choose a playlist.

Segment Choose a segment.

Audio Track Number Choose an audio track.

This action can be used with any other action.

Set Secondary Audio Level

This action sets the volume of the secondary audio. This action applies to all secondary audio tracks.
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Property Description

Audio Level Percentage Enter a numeric value between 1 and 100. Full volume is 100.

This action can be used with any other action.

Turn Secondary Audio/Video On

This action turns on the visibility of the last selected secondary audio and video track.

There are no properties to edit for this action.

This action can be used with any other action.

Turn Secondary Audio/Video Off

This action turns off the currently visible secondary audio and video track.

There are no properties to edit for this action.

This action can be used with any other action.

Mute Secondary Audio

This action mutes the secondary audio.

There are no properties to edit for this action.

This action can be used with any other action.

UnMute Secondary Audio Action

This action unmutes the secondary audio (restores volume if the Mute Secondary Audio action has been 
used).

There are no properties to edit for this action.

This action can be used with any other action.

Sound effect actions
Sound effect actions determine the playback of system sounds. These sounds are not part of the primary 
audio tracks, rather, system sounds are small sound files that you import into your project from the Disc 
Information Files and Groups tab and assign to menu elements and playlist events.

Play Sound

This action causes a system sound to play when the action is executed. Prior to using this action you must 
import sound files into your project.
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To import sound files, go to Disc Information and select the Files and Groups tab. Click the Import Audio 
button and select an audio file. You can import uncompressed LPCM files (.wav) to use as a system sound. 
You are limited to 4 MB of imported sounds in your project. While this number seems small, the system 
sounds are generally very short clicks, whooshes, and other types of sound effects that do not require more 
than a second of running time.

Property Description

Sound Effect Choose the sound file to play when the action is executed.

This action can be used with any other action.

Mute Sound Effects

This action mutes all system sound effects. It does not affect the playback of your primary audio tracks.

There are no properties to edit for this action.

This action can be used with any other action.

unMute Sound Effects

This action unmutes the system sounds. By default, the system sounds are audible, so you would only use 
this action if you have also used the Mute Sound Effects action.

There are no properties to edit for this action.

This action can be used with any other action.
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System actions
System actions are used with the Advanced Parameter (APRM) feature available in DoStudio Authoring. 
The actions affect the values assigned to APRMs during playback of your Blu-ray Disc. These actions are 
intended for use by advanced authors. For more information, see "Advanced authoring" on page 131.

Set Advanced Parameter

In another example, you may wish to set up a YES/NO scenario to track whether your viewer has watched a 
specific video clip on your disc. In that you would assign the Set Advanced Parameter action to something 
like the start of your first title to set the initial value to NO then assign the Set Advanced Parameter action to 
the end of the desired chapter with a value of YES.

Property Description

APRM Select which APRM to assign the action to.

Value Enter the value you wish to assign to the APRM.

This action can be used with any other action.

Set General Purpose Register

This action will set a GPRM value that can be read via HDMV navigation commands in a movie object.

Property Description

GPRM Number Enter the number of the GPRM to assign the action to.

Value Enter the value you wish to assign to the GPRM. Must be a positive number.
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This action can be used with any other action.

Add To Advanced Parameter

This action adds an incremental value of your choosing to an APRM value. For example, if the current value 
of the APRM is 5.5 at the time the Add To Advanced Parameter action is executed, and you have entered 1 
as the amount to add, the action will change the APRM's value to 6.5. You can use this action to count how 
many times a viewer presses a certain button or watches a specific chapter.

Property Description

APRM Select which APRM to assign this action to.

Add Number Enter the value to add.

This action can be used with any other action.

Subtract From Advanced Parameter

This action subtracts an incremental value  from an APRM value. For example, if the current value of the 
APRM is 5.5 at the time the Subtract From Advanced Parameter action is executed and you have entered 
the value of 1 to subtract, the action will change the APRM's value to 4.5.

Property Description

APRM Select which APRM to assign this action to.

Subtract Number Enter the value to subtract.
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This action can be used with any other action.

Multiply Advanced Parameter

This action allows you to multiply the current APRM value by a number you define.

Property Description

APRM Select which APRM to assign this action to.

Number To Multiply Enter the number you wish to use as the multiplier.

This action can be used with any other action.

Divide By Advanced Parameter

This action allows you to divide the current APRM value by a number you define.

Property Description

APRM Select which APRM to assign this action to.

Number To Divide By Enter the number you wish to use as the divisor.

This action can be used with any other action.

Random Number for Advanced Parameter

This action will generate a random number for an APRM's value. The random value will always be a whole 
number integer.
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Property Description

APRM Select which APRM to assign the action to.

Seed Number Define the range for the random number by entering a number 
between 1000 and 5000.

Maximum Number Enter the high value integer.

This action can be used with any other action.

Round Advanced Parameter

This action rounds the current value of an APRM up or down to the nearest whole integer. This is often 
combined with the Divide By Advanced Parameter action.

Property Description

APRM Select which APRM to assign this action to.

This action can be used with any other action.

Absolute Advanced Parameter

This action will set an APRM's value to an absolute number. If you have employed several mathematical 
system actions that could cause your APRM value to be a negative number, the Absolute Advanced 
Parameter action will change the negative number to a positive number.

Property Description

APRM Select which APRM to assign this action to.

This action can be used with any other action.

Move APRM to GPRM

This action will take the value currently stored in an APRM and move it to a GPRM that can be read via 
HDMV commands in a movie object.  GPRMs can only be whole integer values.

Property Description

GPRM Number Enter the number of the GPRM to assign the action to.
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Property Description

APRM Select the APRM you want to move.

This action can be used with any other action.

Move GPRM to APRM

This action will take the value current stored in a GPRM (set by your movie object commands or HDMV 
commands in your IG stream) and move it to an APRM that can be read by conditions and actions.

Property Description

APRM Select the APRM to which you want to move the GPRM.

GPRM Number Enter the number of the GPRM you want to move.

This action can be used with any other action.

Move SPRM to APRM

This action will take the value current stored in a SPRM (System Parameter) and move it to an APRM that 
can be read by conditions and actions.

Property Description

SPRM Number Enter the number of the SPRM to assign the action to.

APRM Select the APRM you want to move.

This action can be used with any other action.

Intellidisc actions

Open Web Page

The Open Web Page action causes a Web page to open in the computer's default browser when the Blu-ray 
Disc is played on a computer in a soft player such as WinDVD, Arcsoft TotalMedia Theatre, or Cyberlink 
PowerDVD. This feature does not work on set top Blu-ray Disc players.

Property Description

URL Enter a fully qualified URL such as http://www.sonycreativesoftware.com.
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This action can be used with any other action.

Animation actions
The animation actions define how a menu block will appear and hide from the screen. The menu blocks 
animate from a position just off screen in the direction you choose: bottom, top, left, or right.

If you do not want to animate the menu block every time it shows or hides, but only at certain times, use 
these animation actions that can be applied to a menu block at any time. If you want a menu block to 
animate every time it shows or hides, use the menu block animation actions. For more information, see 
"Menu block animation actions" on page 105.

Animate Menu Block From The Bottom

This action causes the menu block to animate from the bottom of the screen. Select which menu block you 
want to animate and specify how many pixels you want it to move per frame of video. This action can be 
used with any other action.

Animate Menu Block From The Top

This action causes the menu block to animate from the top of the screen. Select which menu block you 
want to animate and specify how many pixels you want it to move per frame of video. This action can be 
used with any other action.

Animate Menu Block From The Left

This action causes the menu block to animate from the left of the screen. Select which menu block you 
want to animate and specify how many pixels you want it to move per frame of video. This action can be 
used with any other action.
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Animate Menu Block from the Right

This Action causes the menu block to animate from the right of the screen. Select which menu block you 
want to animate and specify how many pixels you want it to move per frame of video. This action can be 
used with any other action.
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Advanced authoring
All DoStudio Authoring actions are subject to conditional execution if you so desire. Conditional execution 
is where the Blu-ray Disc™ evaluates a condition (audio track 1 is currently playing, subtitles are off, the 
main menu is on screen, etc.) and executes a specific action according to the situation described in the 
condition. Conditions allow you to create a Blu-ray Disc that behaves logically according to user input 
rather than simply following a predetermined path.

The most common use for conditions is to determine playback settings (audio track, subtitle track, etc.) and 
adjust the menu display accordingly.

If you are familiar with evaluating System Parameter Register Memories (SPRMs) in DVD projects, you will 
find that conditions serve a similar purpose. Conditions are offered in plain language, so they are easier to 
use. They are also more flexible and powerful since they are governed by BD-J code.

Conditions can be used to create sophisticated logic paths as well, which is useful for gaming, simulation, 
and other advanced authoring techniques.

Using conditions

Adding a condition

Conditions can be added to any element that can receive an action. To review, actions can be assigned to 
menu navigation buttons (Enter, Up, Down, Left, Right), remote control buttons (Play, Pause, Pop-Up 
Menu, Rewind, Fast Forward, Red Button, Green Button, Blue Button, Yellow Button), Title Start, Title End, 
and Chapter Start.

 1. Right-click the element and choose Add Condition.

You can copy and paste conditions that you have assigned to menu elements. Right-click the 
condition and choose Copy(or press Ctrl+C). To paste the condition, right-click the desired 
menu element and choose Paste, or press (Ctrl+V).

 2. Condition Details are displayed in the Control Panel. Conditions are essentially a comparison 
between two values with an associated action that is executed if the condition is met. To set up a 
condition, you must select the values to compare and click Save to save your statement.

In this example, we have set up a condition that checks if the current subtitle equals English.

Chapter 9
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 3. After selecting the values, you must click in the Condition Details tab to save the conditional 
statement.

Field

First you must select a field to evaluate. DoStudio Authoring includes a list of common Blu-ray Disc 
parameters to be evaluated. You can also create your own parameters by setting an Advanced Parameter 
or APRM. For more information, see    "Advanced parameters (APRMs)" on page 135.

The included parameters are:

 n Always Execute

 n Are Subtitles On

 n Current Audio Track

 n Current Chapter

 n Current Playlist

 n Current Secondary Audio Track (future feature)

 n Current Secondary Video Track (future feature)

 n Current Subtitle

 n Is Fast Forwarding

 n Is Main Menu On Screen

 n Is Paused

 n Is Player Profile 1.0

 n Is Player Profile 1.1 (PIP)

 n Is Player Profile 2.0 (BD-Live)

 n Is Playing

 n Is Rewinding

 n Is Secondary Audio/Video On
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 n Is the TV a 3DTV

 n Player Supports 3D BD-J

Operator

The operator is the comparison operation for conditional execution. For all of the included fields, the only 
available operator is Equals to (=). When setting up an APRM, you can choose from a list of comparison 
operators.

Compare With

The Compare With value is dependent upon the value selected in the Field drop-down list. Many of the 
fields contain Yes/No comparisons, while others present a list of available elements in the project.

Condition Compare With

Always Execute Yes/No

Are Subtitles On Yes/No

Current Audio Track List of audio tracks in the project's playlist

Current Chapter List of chapters in the project's playlist

Current Playlist List of current playlists in the project

Current Secondary Audio Track List of secondary audio tracks in the project's playlist

Current Secondary Video Track List of secondary video tracks in the project's playlist

Current Subtitle Yes/No

Is Fast Forwarding Yes/No

Is Main Menu On Screen Yes/No

Is Paused Yes/No

Is Player Profile 1.0 Yes/No

Is Player Profile 1.1 (PIP) Yes/No

Is Player Profile 2.0 (BD-Live) Yes/No

Is Playing Yes/No

Is Rewinding Yes/No

Is Secondary Audio/Video On Yes/No

Is the TV a 3DTV Yes/No

Player Support 3D BD-J Yes/No
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Adding a statement

You can stack multiple conditions by clicking the New Statement button. This allows you to further refine 
the conditions that must be met in order to execute the action. When you have more than one conditional 
statement, you choose whether both statements need to met (And) or whether only one or the other 
condition needs to be met (Or).

In this example, we have created a condition that determines if the current chapter is Title 2 – Chapter 1 
and if the main menu is not on screen (Is Main Menu On Screen = No), then execute the action Show Main 
Menu Block.

Editing or deleting a statement

The Edit button allows you to edit a statement you have already created, and the Delete button deletes a 
statement from your condition.

Actions

The Actions tab is where you assign what action to execute when the condition is met. All of the included 
DoStudio Authoring actions can be assigned to a condition. For more information, see "Using actions" on 
page 103.
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Advanced parameters (APRMs)
In addition to the predefined conditional parameters included with DoStudio Authoring, you can create 
your own advanced parameters that are specific to your project. 

An advanced parameter is essentially a variable that you can create and store values in. Advanced 
parameters are analogous to General Parameter Register Memories (GPRMs) in DVD, so we call them 
APRMs for short. APRMs are far more flexible and powerful than GPRMs. Whereas GRPMs are a limited set 
of eight 16-bit registers, APRMS are plain-language variables to which you can assign any value you want.

In this screen shot, we have created an APRM called HasTrailerPlayed to which we are comparing a value 
of No in order to execute the associated action. In other words, if the viewer hasn't watched the trailer on 
our Blu-ray Disc, then we will execute an action.

Creating an advanced parameter

Creating an APRM is simple; you just need to give it a name. An APRM is a variable of your choice, so make 
it descriptive. You can create a new APRM in two different ways:

 n First, when you right-click an element in the tree and choose Add Condition, the Control Panel 
presents a New Advanced Parameter button.

 n Similarly, the Disc Information Advanced Parameter tab lists the APRMs you have created for your 
project. When you click New you are asked to name your new variable in a dialog. You can assign it 
an initial text or numeric value. If you do not give it an initial value, its default initial value is 0.
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Giving an APRM a value

You can think of an APRM as an empty bucket. You can store anything you want in the bucket for later use, 
but your bucket starts out empty. DoStudio Authoring includes a number of system actions for use with 
APRMs.

For a complete description of the system actions, see "System actions" on page 124.

Using APRMs in a condition

Unlike the conditional fields included with DoStudio Authoring, which evaluate an empirical parameter or 
state of the disc (Current Chapter, Is Main Menu On Screen, etc.), an APRM is a customizable variable that 
can be compared to any type of value. Commonly, authors will assign integer values to APRM using actions 
and then use conditions to evaluate the number value of the APRM and execute a command based on that 
number. In this manner, APRMs are quite similar to GPRMs in DVD.

The system actions work well to manipulate APRM number values with simple math functions such as add, 
subtract, divide, multiply and more.

136        CHAPTER 9          



Alternatively, you can assign text values to your APRM such as Yes/No or True/False and then evaluate the 
condition based on those values.

When you create a condition, you will see your APRMs listed in the Field drop-down list. Unlike the standard 
conditional fields, your APRM can use a variety of operators to compare the value. These operators include 
= (equals to), != (not equals to), < (less than), <= (less than or equals to), > (greater than), and >= (greater 
than or equals to).

In the Value text box, you enter your text or numeric value to make the comparison. Click Save to save the 
conditional statement. Use the Action tab to assign an action that will execute if the condition is met.
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HDMV authoring
This document uses some terminology that is commonplace in Blu-ray Disc™ parlance but may seem 
peculiar or confusing if you are new to Blu-ray Disc authoring.  This document also uses some terminology 
that is specific to DoStudio Authoring:

 n Subpath segments: A list of HDMV menu subsegments.

 n HDMV menu subsegments: HDMV menu-based segment lists that can be applied to any playlist.

 n Movie object: A collection of HDMV commands that controls the navigation of your disc.

Using HDMV Menus
DoStudio Authoring EX Edition can reference HDMV menus (.pes files) in the same way that DoStudio 
Authoring can reference subtitle and audio files.  Each HDMV menu reference can be associated with a 
language if you choose.  This allows you to create one HDMV menu per language.

HDMV menus are grouped by HDMV menu segments.  To create an HDMV menu segment, right-click the 
Subpath Segments node in the Playlist tree and click Add HDMV Menu SubSegment.   Within the HDMV 
menu segment, you can create one or more HDMV menus.  To create an HDMV menu, right-click the 
HDMV Menu Set node and click Add HDMV Menu.
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HDMV menu properties

Selecting the HDMV Menu node in the Playlist tree will present you with the HDMV Menu properties.

Item Description

Name The name of the menu.

Language The language can be used to tell the Blu-ray Disc player which HDMV 
menu to use based on the player's language settings. This is optional.

PES File This is the HDMV menu file.

IG Project File This is the project file for the IG Editor.  When you click Edit it will 
launch the IG Editor.  From the IG Editor, you can then export the PES 
file.  DSA will automatically update the PES file based on your 
exported file.

140        CHAPTER 10          



Adding your HDMV menu segments to a playlist

An HDMV menu segment can be added to any 2D or 3D playlist. Simply select the playlist then drag the 
HDMV menu segment to the Control Panel.  The HDMV menu segment will automatically expand across all 
segments in your playlist.
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Using the Movie Object Editor
After the .pes files are created you might need to use the Movie Object Editor to create your own movie 
objects. Click the Blu-ray Disc Titles node in the Playlist tree and then click the Movie Object Editor tab in the 
Control Panel.

Adding movie objects

Click the Add Movie Object button  to create a movie object.

Deleting movie objects

 1. Select a movie object in the list.

 2. Click the Delete Movie Object button  to delete the selected movie object.

Saving movie objects

Movie objects are saved to the dsamovieobject.domo file in your project's Content folder when you save 
your DoStudio Authoring project.

Validating movie objects

Use the Validation window to check for errors in your movie objects. For more information, see "Validation 
window" on page 38.
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Setting up a BD Title that references movie object numbers
All DoStudio Authoring projects contain the DoStudio BD-J Menu title by default. If your disc is not going 
to use the BD-J menu system, and instead use HDMV menus created with the IG editor, you will need to 
disable the DoStudio BD-J Menu title and add your own BD titles that reference the movie objects you have 
created.

Disabling the DoStudio BD-J Menu title

If you are working with a DSA EX Edition project, the Disable DSA BD-J Menu check box is selected 
for you. For more information, see "Creating projects" on page 29.

 1. Select the DoStudio BD-J Menu title in the Playlist tree to display its properties in the Control Panel.

 2. Select the Disable DSA BD-J Menu check box.

When this box is selected, DoStudio Authoring will not create BD-J files when you compile your 
project.

Adding BD titles

You will need to add BD titles that reference the movie objects that you have created. To add a BD title, 
right-click the Blu-ray Disc Titles node in the Playlist tree and click Add BD Title. A new BD title is added to 
in the tree.

BD title properties

You will see a timeline view in the Control Panel.

Item Description

Name You can rename the title by typing a new name in the Name box.

Number You will notice that each BD title has a unique number. Each new title 
has a number that is one higher than the previous title. If you delete 
a title, all of the titles below it in the tree are re-numbered so the title 
numbers remain sequential.
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Item Description

Include In Title List These settings are used if you are creating a simple play-only BD 
Title. For more information, see "Setting up a play-only HDMV title" 
on page 144. These settings are not used if you reference a movie 
object.

Resume

Search Permitted

Playback Type

Attached MO This setting determines the movie object that is referenced by the BD 
title. Each movie object has a unique ID starting at the number 0. 
Simply type the numeric ID of the movie object in this field. You will 
find the movie object ID in the Movie Object Editor. For more 
information, see "Using the Movie Object Editor" on page 142.

Setting up a play-only HDMV title
DoStudio Authoring allows you to quickly set up a play-only BD title without requiring you to author your 
own movie objects. When you use this feature, DoStudio Authoring automatically sets up the required 
movie objects when you compile. This feature is useful for quickly creating review discs, dailies, or simple 
video loops. This feature is not suitable for discs that require branching or complex menu navigation.

Adding a BD title

Right-click the Blu-ray Disc Titles node in the Playlist tree and click Add BD Title. A new BD title is added to 
the tree.

Adding playlists to the BD title

You can add one or more playlists to the BD title by dragging them from the Playlist tree to the BD title 
timeline in the Control Panel. If you add more than one playlist, the playlists will play in order from left to 
right.

Item Description

Name You can rename the title by typing a new name in the Name box.

Number You will notice that each BD title has a unique number. Each new title 
has a number that is one higher than the previous title. If you delete 
a title, all of the titles below it in the tree are re-numbered so the title 
numbers remain sequential.

Loop Select the Loop check box if you want the video to loop to the 
beginning of the first playlist.
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Item Description

If you do not select the Loop check box, the player will stop playback 
when it reaches the end of the title.

Include In Title List Select the Include In Title List check box to include the title in the 
disc title list.

Resume Select the Resume check box to set the resume intention flag to true 
and allow playback of the title to resume at the point it was playing.

Search Permitted Select the Search Permitted check box to set the title search flag to 
true.

Playback Type Use the list to select Movie or Interactive.

Attached MO This box should be left blank when creating a play-only HDMV title. 
If you reference a movie object in this box, DoStudio Authoring will 
remove the playlists from the BD title timeline.

Blu-ray Title Setup tab
The Blu-ray Title Setup tab allows you to specify the First Play and Top Menu titles in your project. Click the 
Blu-ray Titles node in the Playlist tree then select the Blu-ray Title Setup tab in the Control Panel. In the 
section called BD Title Information, use the combo boxes to choose the First Play and Top Menu titles.

HDMV navigation commands
The following commands will be used to author navigation in your HDMV project. Each command is 
identified as a Movie Object command, or an IG button command.

Command Description

Nop No command.

Nop commands are useful as label placeholders.

GoTo Jumps to a specified command label.

Break Stops executing commands in the current command list.
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Command Description

JumpObject Discards the current movie object and branches to the specified movie object. 
Resuming playback of the previous movie object with the Resume command is 
not possible after executing a JumpObject command.

JumpTitle Discards the current title and branches to the specified title. Resuming playback 
of the previous title with the Resume command is not possible after executing a 
JumpTitle command.

CallObject Suspends playback of the current movie object and branches to the specified 
movie object. Resuming playback of the previous movie object with the Resume 
command is possible after executing a CallObject command.

CallTitle Suspends playback of the current title and branches to the specified title. 
Resuming playback of the previous title with the Resume command is possible 
after executing a CallObject command.

Resume Resumes playback of the previously suspended movie object.

PlayPL Plays the specified PlayList. Only available as a movie object command.

PlayPLatPl Plays the specified PlayItem. Only available as a movie object command.

PlayPLatMk Plays a PlayList from the specified PlayListMark. Only available as a movie 
object command.

TerminatePL Terminates the current PlayList. Only available as a button command.

LinkPl Branches to the specified PlayItem. Only available as a button command.

LinkMK Branches to the specified PlayListMark. Only available as a button command.

StillOn Pauses playback of presentation graphics. Only available as a button 
command.

StillOff Resumes playback of presentation graphics. Only available as a button 
command.

Set Performs an operation using a source and a destination operand, assigning the 
result to the destination operand.

Move (Source) Destination

Stores a value (GPR, PSR, or immediate) in a GPR.

Swap (Source) Destination

Exchange the value of two GPRs.

Add (Source) + (Destination) Destination

Addition

Sub (Destination) – (Source) Destination

Subtraction

Mul (Source) * (Destination) Destination

Multiplication

Div (Destination) / (Source) Destination

Division
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Command Description

Mod (Destination) % (Source) Destination

Modulus

Rnd Random(Source) (Destination)

Generates a random number between 1 and (Source).

And (Source) & (Destination) Destination

Bitwise AND

Or (Source) | (Destination) Destination

Bitwise OR

Xor (Source) ^ (Destination) Destination

Bitwise Exclusive OR

Bit Set 1 <bit number = Source> of Destination

Sets the specified bit of the Destination to 1.

Bit Clear 0 <bit number = Source> of Destination

Sets the specified bit of the Destination to 0.

Shift Left (Destination) Shifted by <count = Source> Destination

Moves the Destination left by the specified number of bits.

Shift Right (Destination) Shifted by <count = Source> Destination

Moves the Destination right by the specified number of bits

SetSystem Sets system values for stream numbers, the Navigation Timer, and button 
parameters.

SetStream Sets the current primary audio, PG TextST, Angle, and Interactive Graphics 
streams to be presented.

SetNVTimer Sets the initial time (0-300 seconds) and starts the timer. When the timer 
reaches 0, a jump operation to the specified movie object is executed.

SetButtonPage Set selected button ID and/or set page ID.

EnableButton Sets the specified button to its normal state, if currently disabled. Commonly 
used to specify the topmost button in a Button Overlap Group (BOG). If the 
specified button is in the same Button Overlap Group as the current button, 
then commands after the EnableButton command continue to be executed.

DisableButton Disables the specified button. If the specified button is the current button, then 
commands after the DisableButton command continue to be executed. If no 
new button has been selected before the end of the command sequence, the 
page's default selected button is selected.

SetSecondaryStream Sets the current secondary video, secondary audio, and PiP PG TextST streams 
to be presented.

Pop up Menu Off Immediately displays the OutEffect of the current page if present, and then 
removes the Interactive Graphics display.
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DoStudio 3D Authoring Module
Add Blu-ray Disc™ 3D authoring to DoStudio EX with the 3D Authoring Module. This module supports BD 
Profile 5, allowing twice the resolution of 3D on a standard Blu-ray Disc.

The 3D Authoring Module allows you to create Hollywood-style Blu-ray Disc 3D products. You'll be able to 
create full menu structures, multiple audio and subtitle streams, and assign depth to pop-up menus and 
subtitles.

3D terminology
This document uses some terminology that may seem peculiar or confusing if you are new to Blu-ray Disc 
authoring. This manual also uses some terminology that is specific to DoStudio. 

Base view

The base  view is the left eye's MVC file. This MVC file is a full-resolution AVC file with additional 
information that can be used by a Blu-ray 3D player.

Dependent view

The dependent view is the right eye's MVC file. This MVC file does not work without the base view file.
 

Setting up 3D segments and playlists
This section describes the steps to set up your 3D segments and create a 3D playlist.

3D segments

Adding a 3D segment

Right-click Audio Video Segments in the Playlist tree and choose Add 3D Segment.  A 3D segment can 
have audio and subtitles added to it.

Chapter 11
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3D segment properties

When you select a 3D segment in the Playlist tree, its properties are displayed in the Control Panel.  You can 
rename the segment by typing a new name in the Name box.

You assign the frame rate of the video in your segment using the Frames Per Second list.  The frame rate 
options for Blu-ray 3D™ are 23.98, 50, and 59.94.  Each segment in a Blu-ray Disc can have a different 
frame rate.

3D segments also contain a path to an optional offset script.  This script can be used to define the z-depth 
of the menu when they appear on screen.  This offset script can define a constant z-depth for the entire 
length of the segment, or it can change the z-depth of the menu over the duration of the segment.

The Offset Usage list contains the following options:
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 n Keep Original – If your MVC file contains offset data it will take priority over the offset data in the 
offset script.

 n Overwrite All – The offset data in the offset script will take priority over any offset data embedded 
in the MVC file.

 n Update PTS Only – Updates the PTS values with values from the script file but maintains the offset 
date in the MVC stream.

Primary video for 3D segments

3D segments require two video files.  When you add a 3D segment you will see two empty video nodes in 
the tree called Base View and Dependent View.

Blu-ray 3D accepts only one video codec called Multiview Video codec, or MVC (.mvc).  MVC format 
includes a full-frame 2D AVC stream, called the base view, and a secondary offset stream called the 
dependent view.  MVC streams are backward compatible with H.264/AVC, which allows standard 2D Blu-
ray Disc players and software to decode stereoscopic video streams.  They play the base view and simply 
ignore the additional information contained in the dependent view.

The MVC format is highly efficient, and the dependent view only adds about 50% extra file size to the 
overall stream.

3D playlists

Creating a 3D playlist

To create a 3D playlist, you use the same process as you would for a 2D segment.  You can right- click the 
3D segment to create a 3D playlist using the selected 3D segment.  You can also create an empty playlist 
and drag a 3D segment to it.

Once a playlist has a 3D segment on it, only 3D segments can be added.  To change the playlist to a 2D 
playlist remove all the 3D segments and then add a 2D segment.  If you have a 2D playlist, only 2D and 
slideshow segments can be added.  To change it to a 3D playlist, remove all the 2D segments and slideshow 
segments, and then add your 3D segment.

3D playlist properties

When you have a 3D playlist that does not have subtitles, the playlist properties will look and work just like 
a 2D playlist, as you can see in the figure below.
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A 3D playlist with subtitles will show you four new properties that are related to your 3D playlist.

3D subtitles can be over the video, or they can be placed in the upper or lower thirds.  Using the Top Offset 
or Bottom Offset settings allows you to position  the 3D subtitles.  If all of the values are 0, then the 
subtitles will appear over the screen.

Top Offset: This field is used to derive TopOffset. TopOffset is the vertical pixel value of the video window 
from top of the frame.

Top Align Offset: This field is used to derive AlignOffset for presentation of Top Aligned PG textST stream 
with subtitle aligned toward the top of the frame. AlignOffset is the vertical coordinate of the output video 
frame where the active video window will be aligned. The top samples contained in the video window are 
positioned at the vertical coordinate AlignOffset in the output video frame.

Bottom Offset: This field is used to derive BottomOffset. BottomOffset is the vertical pixel value of the 
video window from top of the frame.

Bottom Align Offset: This field is used to derive AlignOffset for presentation of Bottom Aligned PG textST 
stream with subtitle aligned toward the bottom of the frame. AlignOffset is the vertical coordinate of the 
output video frame where the active video window will be aligned. The top samples contained in the active 
video window are positioned at the vertical coordinate AlignOffset in the output video frame.
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Completing the 3D disc
To set up your disc so it will play your 3D titles correctly, you will need to set up the default settings 
correctly.  To do this, select Blu-ray Disc Titles in the Playlist tree, and then select the Blu-ray Title Setup tab.

BD3D Information

These settings only pertain to discs made with the 3D module.  These settings tell the Blu-ray Disc player 
what type of 3D video your disc contains and whether the disc should play in 3D mode on startup. For more 
information, see "Blu-ray Disc titles" on page 57.
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3D Player Registers (PSRs)

PSR21: Output Mode preference

The PSR21 contains the Output Mode preference of the user.  The user can set his or his player's setting to 
play a movie in 3D or 2D by default. Navigation commands and BD-J applications cannot change the 
value in PSR21.

Output Mode:

 n 0 = 2D Output Mode for the user's preference

 n 1 = 3D Output Mode for the user's preference

PSR22: Stereoscopic status

The PSR22 represents the current Output Mode and Subtitle Alignment of the Blu-ray Disc player.

When the value of Output Mode contained in PSR22 is changed, video output from the Blu-ray Disc player 
will be changed correspondingly.  When the value of Subtitle Alignment contained in PSR22 is changed, the 
Subtitle Alignment will be changed correspondingly.

Output Mode:

 n 0 = 2D Output Mode for the user’s preference

 n 1 = 3D Output Mode for the user’s preference

Subtitle Alignment:

 n 0 = Not Aligned Subtitle Alignment

 n 2 = Top Aligned Subtitle  Alignment

 n 3 = Bottom Aligned

PSR23: Display capability

PSR23 represents characteristics values of the display connected to the Blu-ray Disc player. Navigation 
commands and BD-J applications cannot change the values contained in PSR23. These values can be 
automatically set by the Blu-ray Disc player before starting playback if the display device can provide them 
through the interface. If these values cannot be obtained automatically, they can be set by the user.  So far, 
every Blu-ray 3D player sets these values for the user.  You can rely on these values to be set correctly.

Stereoscopic display capability:

 n 0 =  The connected TV is incapable of displaying stereoscopic 1920 x 1080/23.976 Hz progressive 
video and stereoscopic 1280 x 720/59.94 Hz progressive video

 n 1 =  The connected TV is capable of displaying stereoscopic 1920 x 1080/23.976 Hz progressive 
video and stereoscopic 1280 x 720/59.94 Hz progressive video
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Stereoscopic 1280 x 720 50p video display capability:

 n 0 =  The connected TV is incapable of displaying stereoscopic 1280 x 720/50 Hz progressive video

 n 1 = Capable of displaying Stereoscopic 1280 x 720/50 Hz progressive video

No glasses required for stereoscopic display:

 n 0 = Viewer needs glasses to watch stereoscopic output mode on the connected TV

 n 1 = Viewer does not need glasses to watch stereoscopic output mode on the connected TV

Horizontal display size (in centimeters):

 n 0x000 =  Undefined

 n 0x001 to 0xFFE =  Connected display's horizontal size in centimeters (0xFFE means horizontal 4094 
centimeter display)

 n 0xFFF =  horizontal 255 centimeter or bigger displays

PSR24: 3D capability

The PSR24 represents the 3D capability of the BD-ROM Player. Navigation commands and BD-J 
applications cannot change the value contained in PSR24.

Stereoscopic 1280 x 720 50p video capability:

 n 0 = Incapable of stereoscopic 1280x720/50Hz progressive video presentation

 n 1 = Capable of stereoscopic 1280x720/50Hz progressive video presentation

Stereoscopic 1280 x 720 CABAC decoding capability:

 n 0 = Incapable of decoding stereoscopic 1280 x 720/59.94 Hz and stereoscopic 1280 x 720/50Hz 
with the entropy_coding_mode_flag indicating CABAC

 n 1 = Capable of decoding stereoscopic 1280 x 720/59.94Hz and Stereoscopic 1280 x 720/50Hz with 
the entropy_coding_mode_flag indicating CABAC

Stereoscopic PG capability:

 n 0 = Incapable of stereoscopic PG presentation

 n 1 = Capable of stereoscopic PG presentation

Stereoscopic IG capability:

 n 0 = Incapable of stereoscopic IG presentation

 n 1 = Capable of stereoscopic IG presentation

Dialog region offset capability:

 n 0 =  Incapable of presentation function of dialog_region_offset of stereoscopic TextST

 n 1 = Capable of presentation function of dialog_region_offset of stereoscopic TextST

BD-J capability during stereoscopic output mode:
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 n 0 = BD-J incapable during stereoscopic output mode:

 n 1 = BD-J capable during stereoscopic output mode

Secondary audio capability during stereoscopic output mode:

 n 0 = Secondary audio incapable during stereoscopic output mode

 n 1 = Secondary audio capable during stereoscopic output mode

PSR example

Move gpr55 psr31
 And gpr55 1245760 (or 0x130240)
 If gpr55 == 1245760 (then this is a 3D player)

Move gpr55 psr23
 And gpr55 1 (or 0x1)
 If gpr55 == 1  (then the TV can play 23.976 1920 in 3D)

If your glasses are not connected normally psr23 returns 0.

3D commands

SetOutputMode

The SetOutputMode command sets the output mode to 2D or 3D PSR22 (see "PSR22: Stereoscopic status" 
on page 154). This command should not be use in the IG Editor. Always check if the player is a 3D player 
before using this command.

 n 0 = 2D Output Mode

 n 1 = 3D Output Mode

Example:

SetOutputMode 1

SetStreamSS

The SetStreamSS command has the same function as SetStream command. The SetStreamSS command 
sets values for any or all of the primary audio stream, subtitle stream, angle and IG stream to be presented. 
In addition to the functions, the SetStreamSS Command sets values for subtitle alignment. This command 
can be used only when the output mode in PSR22 is set to 3D. This command shall be ignored or treated as 
Nop command when the output mode in PSR22 is set to 2D. Always check if the player is a 3D player 
before using this command.
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Compiling and formatting your 3D disc

Compiling

When you compile your Blu-ray Disc with a 3D Playlist, DoStudio Authoring will automatically create an 
ISO that you can burn to a BD-R/RE or mount and play back on a softplayer.   The ISO will be found in your 
.BD folder's 3DISO folder.

You can compile your 3D project to a 2D Blu-ray Disc by choosing Compile > Compile 2D Blu-ray Disc. You 
can also click the Compile 2D Blu-ray Disc button the toolbar or press Shift+F6. Compiling your 3D project 
to a 2D Blu-ray Disc takes less time than compiling to a 3D disc, giving you more time for testing.

For more information, see "Compiling your Blu-ray Disc" on page 63.

Formatting

When you are ready to format your disc for replication, DoStudio Authoring will not create the ISO and will 
do the same steps as a 2D disc.

For more information, see "Formatting your Blu-ray Disc for replication" on page 67.

3D metadata offset file (.do3d)
The .do3d ASCII text file is used to position subtitles on the screen. Subtitles can appear at a fixed 3D 
depth, or they can move in 3D space as the video plays. Each line is treated as separate input line. Blank 
lines are allowed, and comments are allowed at the START of the line by using the pound key (#).

The .do3d text file is based on a sequence of depth offsets for duration of frames as seen below.

For every duration of frames (DOF), there must be the same number of offset sequences (NOS). In the 
preceding example, there are 3 offsets. This means that it is important to group the various changes in 
depth into equal numbers. For example, if we have a  2 minute, 24 fps video and there are 100 different 
offset depth values, we can group the offsets into 10 NOS every 288 frames: 120 seconds x 24 frames per 
second / 100 = 288 frames.

Each NOS is a positive or negative number indicated by + or – without a space between the number. For 
example, +1 would move a subtitle in front of screen depth, and -3 would move a subtitle behind screen 
depth.

The .do3d file doesn't include any information that points directly to the .dost file. The reason for this is that 
the two are completely independent, allowing for subtitle playback on 2D and 3D players.
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The .do3d file is also used to create a depth map for the BD-J and HDMV menus, allowing the menus to 
move with the 3D video.

The .do3d header

The header is includes just three important values:

#Version must be set to 1.00

Version 1.00

#NumerOfOffsetSequence will indicate the number of NOS per DOF.

#This means that EVERY DOF will have this number.

#In this case every DOF will have 10 NOS

NumerOfOffsetSequence  10

# Default offset direction used for those frame not described in this 
script.

# Number of offset should be the same as NumOfSequence

DefaultOffset +1 +5 +10 +15 -1 -5 +15 +2 +10 +4

The .do3d body

The body is a list of DOF NOS per line, and each line is based on the previous DOF. Using our example of 10 
NOS every 288 DOF, the first DOF would be 288, the next DOF would be 288, and so on. After the DOF, 
include a tab character and then the NOS:

#DOF NOS

0 +288 +12 -5 + 14 -7 +1 +5 +15 -5 -15 -30

289 +288 +5 -7 +1 -5 +5 -15 +2 -30 -4 +5

577 +288 +12 -5 + 14 -7 +1 +5 +15 -5 -15 -30

If the DOF isn't even, we'd have the following:

#DOF(tab)NOS

# This indicate starting at 0 to 30 frames in the DOF

0 +30  +1 +2 +3 +4 +5 +6 +7 +8 +9 +10

# This indicate starting at 31 to 120 frames in the DOF

31 +89 +1 +2 +3 +4 +5 +6 +7 +8 +9 +10

# This indicate starting at 121 to 150 frames in the DOF

121 +29 +1 +2 +3 +4 +5 +6 +7 +8 +9 +10
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Appendices
This section contains valuable references for working efficiently with DoStudio Authoring.

Using ImgBurn
In order to play your discs on a set-top player, you will need to burn a disc. DoStudio Authoring does not 
include direct burning capability at this time, so you will need to use a third party burning tool. This section 
describes how to burn a BD-R/-RE with ImgBurn, a popular freeware burning tool. You can download 
ImgBurn from its official website at http://www.imgburn.com/. You can also use a commercial burning 
application such as Nero Burning ROM or Corel's Burn.Now (included with the consumer-oriented Movie 
Factory suite).

Regardless of the burning tool you use, you will need to compile your disc in DoStudio Authoring and then 
burn the contents of the Disc folder as UDF 2.5.

BD-Rs are write-once media (the DVD analogy is a DVD-R or DVD+R). BD-REs are rewritable Blu-ray Disc™ 
media (like DVD-RW). BD-Rs are still rather expensive, so we recommend buying a few BD-REs for testing. 
They are quick to erase and are reliable for many hundreds of sessions.

 1. Start ImgBurn and click the Write files/folders to discbutton.

 2. Choose File > Browse for a source folder.
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 3. Browse to the Disc folder that is created when you compile your disc in DoStudio Authoring. The 
Disc folder is found inside the yourprojectname.BD folder that is created when you compile. The 
Disc folder contains two subfolders: the BDMV folder and the CERTIFICATE folder.

 4. Click the Options tab and select UDF 2.5 as the file format for the burn.

Your disc will not play unless it is formatted UDF 2.5.
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 5. Click the Labels tab and name your disc. This step is optional.

 6. Click the Build button and you're done.

If your BD-RE already has content on it you will be prompted with a window asking if you want to 
continue. If you click Yes, ImgBurn will overwrite the existing content.
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Your disc will play in any set-top Blu-ray Disc player that accepts BD-R/RE. Most Blu-ray Disc players 
will play BD-R/RE. The Sharp Aquos players are the notable exception – they will only play replicated 
discs.

Time-saving tips for burning test discs

You will generally need to test your menu authoring and navigation frequently, but you will not necessarily 
change your video assets every time. DoStudio Authoring includes a time-saving feature that allows you to 
turn video/audio multiplexing off when you compile. This setting is found in the Disc Settings control panel. 
You must compile your disc with video and a first play image at least once before you can turn off 
multiplexing. Then, if you are making authoring changes to your menus but not altering your video, you 
may compile your disc quickly with multiplexing off, and DoStudio Authoring will keep your previous mux 
but recompile your menu.

A second time-saving trick relates to burning test discs for playback on a set-top player. Again, you will 
likely be authoring and testing your menu navigation more than your video stream. Author your menus first 
with short placeholder video clips in the titles. This way, your compiled image will be much smaller – maybe 
under a few hundred megabytes – and you will be able to burn a disc that much faster. When you are 
satisfied with your menus, drop your real video into each title and recompile.

Testing your projects during the authoring process

In general, you will view and test your project on your PC throughout the authoring process using WinDVD 
or ArcSoft TotalMedia Theatre. This is fast and convenient. It is important, however, to burn your projects 
to BD-R/RE and test your discs on set-top players as well.

PC softplayers offer full-spec playback; however, they do not necessarily perform the same way a set-top 
player will in terms of loading times, animation playback, and speed of jumping titles. There are also 
performance differences among the various players currently on the market.
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The DoStudio Authoring engine includes benchmarking capabilities that test each player's capabilities and 
adjust the animation accordingly; however, you will still encounter performance issues if you attempt to 
have multiple animations on screen simultaneously, etc.

The Sony PlayStation®3 is the gold standard for performance. It is useful to have one in your studio for 
testing. It is also good to have a mid-range profile 1.1 player on hand such as the Sony BDP-S300 or 
similar. Finally, you may want to have a first-generation player on hand to test the worst-case playback 
scenario.

Basic Blu-ray Disc specification information for authors

Maximum bit rate

As with DVD, calculating the total bit rate of your Blu-ray Disc is of paramount importance. The following 
table compares the maximum allowable bit rates for Blu-ray Disc and DVD respectively.

It is important to keep in mind that your primary video and secondary video tracks must mot exceed the 
maximum video bit rate of 40.0 Mbps.

  Maximum video bit rate Maximum total bit rate

Blu-ray Disc 40.0 Mbps 48.0 Mbps

DVD 9.8 Mbps 10.08 Mbps

Primary video streams for 2D Blu-ray Disc

Frame size (pixels) Frame rate (Hz) Progressive/Interlace Aspect ratio

1920x1080 29.97 Interlace 16:9

25 Interlace

23.976 Progressive

24 Progressive

1280x720 59.94 Progressive 16:9

50 Progressive

23.976 Progressive

24 Progressive

720x480 29.97 Interlace 4:3 or 16:9

720x576 25 Interlace 4:3 or 16:9

Mandatory audio codecs for Blu-ray Disc

The Blu-ray Disc format adds quite a few new options for audio compression. The table below lists the 
audio formats that are required for all Blu-ray Disc players, so your projects can make use of any or all of 
these formats and play back successfully.

The viewer's actual hardware setup (Blu-ray Disc player + AV receiver) will determine whether they will 
actually hear your beautiful 7.1 surround in 7.1 or whether it will be downconverted to 5.1 or stereo.

APPENDICES           163   



It is important to note that some of the new audio codecs for Blu-ray Disc can take up a significant 
amount of available bit rate bandwidth.

Codec Sample rate Bit rate Channels

Linear PCM 48/96/192 Khz 27.6 Mbps 8

Dolby Digital 48 Khz 640 Kbps 5.1

Dolby Digital Plus 48 Khz 0.640 Kbps/4.736 Mbps 5.1/7.1

Dolby TrueHD 48/96/192 Khz 0.640 Kbps/18.64 Mbps 2/6/8

DTS 48 Khz 1.509 Mbps 5.1

DTS-HD High Resolution 48/96 Khz 1.509 Mbps/6.0 Mbps 6.1/7.1

DTS-HD Master Audio 48/96/192 Khz 24.5 Mbps 7.1

AACS for independent producers
For more information about the AACS process and fees for new Blu-ray Disc authors, please see the "AACS 
for Independent Producers" wikipaper:  http://www.netblender.com/main/resources/wikipapers/aacs-for-
independent-producers/.

Exporting chapter markers from Vegas Pro
You can mark your chapter points in your Sony Vegas Pro timeline and export them to an XML file using the 
Export Chapters script.

Creating chapter markers in Vegas Pro

 1. Position the cursor where you want to add a marker.

 2. Choose Insert > Marker. A marker is added at the cursor position and an edit box is displayed.

 3. Type a name for the marker in the edit box and press Enter.

You can also insert markers by pressing the M key.

Exporting chapter markers from Vegas Pro

Use the Export Chapters script in Vegas Pro 11 and later to export your chapter markers to an XML file that 
can be read by DoStudio Authoring.

 1. Choose Tools > Scripting > Export Chapters.

The Export Chapter Information dialog box appears.
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 2. Select the drive and folder where you want to save the file.

 3. Type a name in the File name box.

 4. Select XML Chapters List in the Save as type list.

 5. Click the Save button.

For more information about importing chapter markers from Vegas Pro, see "Importing chapters from a 
Sony Vegas Pro XML file" on page 55.

Exporting chapter markers from Final Cut Pro
You can mark your chapter points in your Final Cut Pro timeline and export them using Apple's Final Cut 
Pro XML.

Creating chapter markers in Final Cut Pro

 1. Place the playhead in your timeline at the location where you would like to create a chapter. Press M 
to add a marker. Press M again to edit the marker's information.

 2. Click the Done button.

 3. Repeat this wherever you want to create a chapter.

Exporting chapter markers from Final Cut Pro

DoStudio Authoring uses the XML file that you can export from Final Cut Pro to import your chapter 
markers. To export the XML file, select the sequence that contains your video and your chapter markers, 
then select File > Export XML.

For more information about importing chapter markers from Final Cut Pro, see "Importing chapters from a 
Final Cut Pro XML file" on page 55.
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BD Touch and DoStudio Authoring
A Blu-ray Disc created with DoStudio Authoring automatically includes BD Touch. This built-in technology 
lets viewers use their Apple® iPhone® or iPod touch® to control the Blu-ray Disc using the BD Touch iOS 
application. As an author you can download the free BD Touch Metadata Editor in the Smart Support Tool. 
This application lets you add bonus content to your disc such as videos, .mp3 files, and photos that will be 
transferred from the disc to the iPhone or iPod touch with the BD Touch iOS application.

Keyboard shortcuts
The following keyboard shortcuts can help streamline your work in DoStudio Authoring. The available 
keyboard shortcuts are arranged in tables according to function.

Project file shortcuts

Command Keyboard Shortcut

Start new project. Ctrl+N

Open existing project. Ctrl+O

Save project. Ctrl+S

Print project report. Ctrl+P

General editing shortcuts

Command Keyboard Shortcut

Start Mosaic. F3

Create main menu block. F4

Import playlist. Ctrl+Shift+I

Compile and formatting shortcuts

Command Keyboard Shortcut

Compile Blu-ray Disc. F5

Compile 3D Disc as 2D Disc Shift+F6

Quick Compile F6

Format Blu-ray Disc Shift+F5

Window and layout shortcuts

Command Keyboard Shortcut

Show Playlist window. F7

Show Menu Elements window. F8

Show Control Panel window. F9
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Command Keyboard Shortcut

Show Layout Preview window F10

Show Layout Editor window. F11

Show Validation window. Shift+F7

Hide all windows except the Layout Editor. F12

Load layout. Ctrl+Alt+L

Save layout. Ctrl+Alt+S

Set as default layout. Ctrl+Alt+D

Load default layout. Ctrl+Alt+R

Mosaic shortcuts

Command Keyboard Shortcut

Import to DoStudio Authoring. Ctrl+I

Add .psd file. F3

Clear all F11
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